


July 3, 2012

1

          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF 
document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.
2. Enter the text to find in the text box.
3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in 
the box.  For example, if you search for the word stick, the words tick and sticky will 
not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in 
the box.

Find Backwards starts the search from the current page and goes backwards through 
the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.
       
To find the next occurrence of the word, Do one of the following:
           
            Choose Edit > Find Again 
            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 
into another application such as a word processor.  You can also paste text into a PDF 
document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the 
copied text, the font cannot be preserved.  A default font  is substituted.
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To select and copy it to the clipboard:
1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 
(Mac OS) as you drag across the width of the document. 
       
To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 
(Mac OS) as you drag the length of the document.
        
To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 
on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 
in the document is selected.  When you release the mouse button, the selected text is 
highlighted.  To deselect the text and start over, click anywhere outside the selected text.  
The Select All command will not select all the text in the document.  A workaround for this 
(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
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1 [REPORT OF ACTION TAKEN IN CLOSED SESSIONS ON TUESDAY, JULY 3, 

2 2012, READ BY CLERK SACHI HAMAI DIRECTLY BELOW AND ON PAGE 87]

3

4

5

6 SUP. YAROSLAVSKY, CHAIRMAN: GOOD MORNING. THE MEETING OF THE 

7 BOARD OF SUPERVISORS IS NOW IN SESSION. OPEN SESSION. SACHI, 

8 DO YOU WANT TO MAKE A REPORT ON THE CLOSED SESSION? 

9

10 CLERK SACHI HAMAI: YES. WITH RESPECT TO ITEM NO. CS-2, PUBLIC 

11 EMPLOYMENT CONSIDERATION OF CANDIDATE FOR THE APPOINTMENT TO 

12 THE POSITION OF DIRECTOR OF PUBLIC SOCIAL SERVICES. AS 

13 INDICATED ON THE SUPPLEMENTAL AGENDA, THERE IS NO REPORTABLE 

14 ACTION. THANK YOU. 

15

16 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. NEXT IS I'M GOING TO ASK 

17 EVERYONE TO RISE FOR THE INVOCATION AND THE PLEDGE OF 

18 ALLEGIANCE. THE INVOCATION WILL BE LED BY PASTOR JACKSON LAU 

19 OF THE FIRST CHINESE BAPTIST CHURCH IN WALNUT. THE PLEDGE OF 

20 ALLEGIANCE WILL BE LED BY CHRISTOPHER DUARTE, VETERANS' CLAIM 

21 ASSISTANT FOR THE DEPARTMENT OF MILITARY AND VETERANS' 

22 AFFAIRS, HAILING FROM PACOIMA. PASTOR LAU? 

23

24 PASTOR JACKSON LAU: GOOD MORNING. HAPPY FOURTH OF JULY. LET US 

25 PRAY TOGETHER. AWESOME AND HOLY GOD, WE JUST THANK YOU, WE 
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1 JUST THANK YOU FOR THE FREEDOM THAT WE HAVE IN THIS COUNTRY. 

2 WE THANK YOU FOR BEING ALIVE WHERE YOU HELP US TO TRULY 

3 TREASURE THIS AWESOME FREEDOM AND NOT TAKE IT FOR GRANTED EVEN 

4 THOUGH WE EXPERIENCE IT EACH AND EVERY DAY. AND WE WANT TO 

5 ESPECIALLY GIVE YOU THANKS FOR THE MEN AND THE WOMEN WHO GIVE 

6 OF THEMSELVES SO THAT WE MAY HAVE THIS FREEDOM. AND THIS 

7 MORNING RIGHT NOW WE WANT TO PRAY FOR OUR SUPERVISORS AND 

8 THEIR WORKERS AND OUR NATIONAL LEADERS WHO SEEK TO EXERCISE 

9 AND PRESERVE THIS FREEDOM. LORD, YOUR WORD TELLS US THAT WE 

10 ARE TO ASK, SEEK AND KNOCK FROM YOU AND THAT WE DON'T HAVE 

11 BECAUSE WE DON'T ASK. AND WE ASK AND WE DON'T RECEIVE BECAUSE 

12 WE ASK WITH WRONG MOTIVES. AS WE CELEBRATE THE INDEPENDENCE 

13 DAY, LET US NOT BE INDEPENDENT FROM YOU AND, THEREFORE, WE 

14 HUMBLY ASK WITH PURE MOTIVE YOUR GUIDANCE UPON THESE LEADERS. 

15 AND WE PRAY, LORD, THAT YOU WOULD GIVE EACH ONE OF THEM DEEP 

16 WISDOM AND ALLOW THEM TO HAVE THE DISCERNMENT BETWEEN GOOD AND 

17 EVIL, AND ESPECIALLY BETWEEN THE GOOD, THE BETTER AND THE 

18 BEST. MAY THEIR LIVES AND THEIR DECISIONS PLEASE YOU, 

19 ESPECIALLY WHEN IT'S HARD TO PLEASE EVERYONE. MAY THEY SENSE 

20 YOUR PRESENCE IN THIS ROOM THIS DAY AND MAY THEY UNDERSTAND 

21 YOUR LOVING CARE FOR EACH AND EVERY PERSON HERE. WE ASK IT, 

22 LORD, FOR YOUR GLORY AND THE GOOD OF THE PEOPLE WE SERVE, 

23 AMEN. 

24
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1 CHRISTOPHER DUARTE: PLEASE REMAIN STANDING AND FACE THE 

2 COLORS, AND PLACE YOUR RIGHT HAND OVER YOUR HEART. [PLEDGE OF 

3 ALLEGIANCE RECITED.] 

4

5 SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR KNABE? 

6

7 SUP. KNABE: THANK YOU, MR. CHAIRMAN, MEMBERS OF THE BOARD. 

8 IT'S MY PLEASURE TO ONCE AGAIN WELCOME BACK AND THANK PASTOR 

9 JACKSON LAU, WHO IS THE SENIOR PASTOR AT THE FIRST CHINESE 

10 BAPTIST CHURCH OF ROWLAND HEIGHTS. PASTOR LAU WAS BORN IN 

11 CANTON, CHINA, AND EMIGRATED TO LOS ANGELES IN 1956. HE 

12 ATTENDED U.C.L.A. FOR HIS UNDERGRADUATE STUDIES AND 

13 SUBSEQUENTLY GRADUATED IN 1973 FROM U.S.C. WITH A DOCTOR OF 

14 PHARMACY. HE PRACTICED HOSPITAL PHARMACY FOR 10 YEARS IN THE 

15 SAN FERNANDO VALLEY. HE THEN ATTENDED AND GRADUATED WITH A 

16 MASTER OF DIVINITY FROM TALBOT SCHOOL OF THEOLOGY FROM BIOLA 

17 UNIVERSITY IN 1984. HE AND HIS WIFE, MILLIE, WERE CALLED BY 

18 THE FIRST CHINESE BAPTIST CHURCH IN LOS ANGELES IN SEPTEMBER 

19 1984. THEY WERE ASSIGNED TO PLANT A CHURCH IN THE EAST SAN 

20 GABRIEL VALLEY BEGINNING IN MARCH OF 1985, WHICH BECAME THE 

21 FIRST CHINESE BAPTIST CHURCH, ROWLAND HEIGHTS. THEIR 

22 CONGREGATION NUMBERS OVER 1,000 MEMBERS. FOR THE PAST FIVE 

23 YEARS, THE FIRST CHINESE BAPTIST CHURCH HAS PARTNERED WITH THE 

24 EAST SAN GABRIEL VALLEY COALITION FOR THE HOMELESS TO PROVIDE 

25 A WINTER SHELTER PROGRAM. THIS YEAR THEY HOSTED OVER 170 
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1 HOMELESS EVERY NIGHT FROM JANUARY 18 THROUGH FEBRUARY 2 AND 

2 SERVED OVER 2,500 MEALS. SO ON BEHALF OF MY COLLEAGUES AND THE 

3 BOARD, WE'D LIKE TO TAKE THE TIME TO THANK PASTOR FOR TAKING 

4 TIME OUT OF HIS BUSY SCHEDULE TO JOIN US, LEADING US IN A 

5 WONDERFUL INVOCATION, BUT THANK HIM FOR ALL THAT HE DOES NOT 

6 JUST EVERY DAY AS A PASTOR OF THAT CHURCH BUT FOR THE ENTIRE 

7 COMMUNITY. GOD BLESS YOU, MY FRIEND. [APPLAUSE.] 

8

9 SUP. YAROSLAVSKY, CHAIRMAN: CHRISTOPHER DUARTE? YOU LED US IN 

10 THE PLEDGE OF ALLEGIANCE THIS MORNING. COME ON OVER HERE, 

11 CHRIS, WHO LED US IN THE PLEDGE OF ALLEGIANCE THIS MORNING IS 

12 REPRESENTING THE LOS ANGELES COUNTY DEPARTMENT OF MILITARY AND 

13 VETERANS' AFFAIRS, WHERE HE SERVES AS A VETERANS' CLAIM 

14 ASSISTANT. CHRISTOPHER SERVED FROM 1997 THROUGH 2001 AS A 

15 SERGEANT, OBTAINING THE RANK OF SERGEANT IN THE UNITED STATES 

16 MARINE CORPS, THE FIFTH MARINE REGIMENT. HE IS, AS I SAID, IS 

17 A VETERANS COUNSELOR WITH THE COUNTY DEPARTMENT OF MILITARY 

18 AND VETERANS AFFAIRS. HE LIVED IN OUR DISTRICT FOR 34 YEARS. 

19 ATTENDED LOS ANGELES COLLEGE AND THE UNIVERSITY OF PHOENIX IN 

20 WOODLAND HILLS. HE'S A GRADUATE ALSO OF BISHOP ALEMANY HIGH 

21 SCHOOL IN MISSION HILLS. SO HE'S A THIRD DISTRICT RESIDENT 

22 THROUGH AND THROUGH. CHRISTOPHER, THANK YOU VERY MUCH FOR 

23 LEADING US IN THE PLEDGE THIS MORNING AND THANK YOU FOR YOUR 

24 SERVICE TO OUR COUNTRY. [APPLAUSE.] 

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: SACHI, IF YOU CALL THE AGENDA, 

2 WE'LL GET ON OUR WAY? 

3

4 CLERK SACHI HAMAI: GOOD MORNING, MR. CHAIRMAN, MEMBERS OF THE 

5 BOARD, WE WILL BEGIN TODAY'S AGENDA ON PAGE 3, AGENDA FOR THE 

6 MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION. ON ITEMS NO. 

7 1-D AND 2-D, WE WILL HOLD THESE FOR A MEMBER OF THE PUBLIC. ON 

8 PAGE 4, BOARD OF SUPERVISORS, ITEMS 1 THROUGH 9. ON ITEM NO. 

9 1, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS 

10 ITEM. ON ITEM NO. 2, SUPERVISOR RIDLEY-THOMAS AND SUPERVISOR 

11 ANTONOVICH ABSTAIN FROM THE VOTE. AND ON THIS ITEM, THERE'S A 

12 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD IT. ON ITEM NO. 3, 

13 THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS 

14 ITEM. ON ITEM NO. 4, SUPERVISOR RIDLEY-THOMAS AND MEMBERS OF 

15 THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 7, 

16 SUPERVISOR MOLINA VOTES NO ON THIS ITEM AND ALSO THERE'S 

17 REQUESTS FROM MEMBERS OF THE PUBLIC TO HOLD IT. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: I'M A NO VOTE, AS WELL. 

20

21 CLERK SACHI HAMAI: ON ITEM NO. 7? 

22

23 SUP. YAROSLAVSKY, CHAIRMAN: YES. 

24
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1 CLERK SACHI HAMAI: OKAY. AND THE REMAINING -- EXCUSE ME ON 

2 ITEM NO. 9, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO 

3 HOLD THIS ITEM. AND THE REMAINING ITEMS UNDER THE BOARD OF 

4 SUPERVISORS ARE BEFORE YOU. AND YOU MIGHT HAVE TO TAKE UP 

5 EITHER 2 OR 7 AS A SEPARATE VOTE. 

6

7 SUP. YAROSLAVSKY, CHAIRMAN: 2? 

8

9 CLERK SACHI HAMAI: 2 BECAUSE SUPERVISOR ANTONOVICH AND 

10 SUPERVISOR RIDLEY-THOMAS ABSTAIN. 

11

12 SUP. YAROSLAVSKY, CHAIRMAN: LET'S TAKE UP ITEM NO. 2. MOVED BY 

13 KNABE. I'LL SECOND IT WITH ANTONOVICH AND RIDLEY-THOMAS 

14 ABSTAINING, THERE ARE THREE VOTES TO APPROVE IT. ITEM 7 WE 

15 HAVE MEMBERS OF THE PUBLIC WHO WANT TO BE HEARD. MEMBERS OF 

16 THE PUBLIC WANT TO BE HEARD ON EACH OF THOSE, SO LET'S HOLD 

17 THEM. I'M SORRY. ITEM 2 WILL BE HELD AS WELL. GO AHEAD. 

18

19 CLERK SACHI HAMAI: YOU'RE ABSOLUTELY RIGHT, I APOLOGIZE. AND 

20 THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS ARE BEFORE 

21 YOU. 

22

23 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. IT'S MOVED BY KNABE. 

24 SECONDED BY ANTONOVICH. WITHOUT OBJECTION, UNANIMOUS VOTE. 

25
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1 CLERK SACHI HAMAI: CONSENT CALENDAR ITEMS 10 THROUGH 53. ON 

2 ITEMS NO. 10 THROUGH 17, THERE'S A REQUEST -- EXCUSE ME. I'LL 

3 READ 10 THROUGH 12, THERE'S A REQUEST FROM A MEMBER OF THE 

4 PUBLIC. LET ME BACK UP. I APOLOGIZE. ON ITEM NO. 10, 

5 SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE REFERRED BACK TO 

6 THE CORPORATION, THE LOS ANGELES ECONOMIC DEVELOPMENT 

7 CORPORATION. BUT ON THIS ITEM, SUPERVISOR ANTONOVICH AND A 

8 MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM 

9 NO. 11 AND 12, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC 

10 TO HOLD THESE ITEMS. 

11

12 SUP. KNABE: REFER BACK TO THE C.E.O.? 

13

14 CLERK SACHI HAMAI: OH, REFER BACK TO THE C.E.O.? OKAY, BUT ON 

15 THIS ITEM SUPERVISOR ANTONOVICH IS ALSO HOLDING IT ALONG WITH 

16 A MEMBER OF THE PUBLIC. ON ITEM NO. 13 AND 14, THE CHIEF 

17 EXECUTIVE OFFICER REQUESTS THAT THESE ITEMS BE CONTINUED ONE 

18 WEEK TO JULY 10, 2012. BUT ALSO ON THESE ITEMS, THERE'S A 

19 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THEM. ON ITEMS NO. 

20 15, 16, 17, 18 AND 19, THERE IS A REQUEST FROM A MEMBER OF THE 

21 PUBLIC TO HOLD THESE ITEMS. ON ITEM NO. 26, SUPERVISOR KNABE 

22 AND SUPERVISOR ANTONOVICH AND A MEMBER OF THE PUBLIC REQUEST 

23 THAT THIS ITEM BE HELD. ON ITEM NO. 28 -- 

24

25 SUP. YAROSLAVSKY, CHAIRMAN: WHICH ITEM WAS THE LAST ONE? 
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1

2 CLERK SACHI HAMAI: 26. 

3

4 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. 

5

6 CLERK SACHI HAMAI: ON ITEM NO. 28, 29 AND 30, THERE'S -- AND 

7 EXCUSE ME, 31, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC 

8 TO HOLD THESE ITEMS. ON ITEM NO. 35, THERE'S A REQUEST FROM A 

9 MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND ALSO ON THAT ITEM 

10 NO. 36, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD 

11 THIS ITEM. AND I'M SORRY, AS WE'RE GOING ALONG, THERE'S A 

12 MEMBER THAT CONTINUES TO SIGN UP, SO ON ITEM NO. 33, WE WILL 

13 ALSO HOLD IT FOR A MEMBER OF THE PUBLIC. ON ITEM NO. 39, AS 

14 INDICATED ON THE SUPPLEMENTAL AGENDA, THE FIRE CHIEF REQUESTS 

15 THAT THIS ITEM BE REFERRED BACK TO HIS DEPARTMENT. ON ITEM NO. 

16 44, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED ONE 

17 WEEK TO JULY 10, 2012. ON ITEM NO. 45, SUPERVISOR KNABE ALSO 

18 REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 10, 

19 2012. ON ITEM NO. 48, THE CHIEF EXECUTIVE OFFICER REQUESTS 

20 THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 10, 2012. ITEMS 

21 NUMBER 37, 39 AND 40 ARE ALSO NOW BEING REQUESTED TO BE HELD 

22 BY A MEMBER OF THE PUBLIC. AND THE REMAINING ITEMS UNDER THE 

23 CONSENT CALENDAR ARE BEFORE YOU. 

24
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1 SUP. YAROSLAVSKY, CHAIRMAN: MOVED BY KNABE. SECONDED BY 

2 MOLINA. WITHOUT OBJECTION, UNANIMOUS VOTE. 

3

4 CLERK SACHI HAMAI: DISCUSSION ITEM, ITEM NO. 54, WE WILL HOLD 

5 FOR A DISCUSSION. SUPPLEMENTAL AGENDA -- EXCUSE ME, ON PAGE 

6 26, MISCELLANEOUS, ADDITIONS TO THE AGENDA WHICH WERE POSED 

7 MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON 

8 THE SUPPLEMENTAL AGENDA. ON ITEM NO. 55-A AND ITEM 55-B, 

9 THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE 

10 ITEMS. ON PAGE 29, NOTICES OF CLOSED SESSION, ON ITEM NO. CS-

11 3, AS INDICATED ON THE SUPPLEMENTAL AGENDA, COUNTY COUNSEL 

12 REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 10, 

13 2012. 

14

15 SUP. YAROSLAVSKY, CHAIRMAN: WHICH ITEM IS THAT? 

16

17 CLERK SACHI HAMAI: CS-3. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, SO ORDERED. 

20

21 CLERK SACHI HAMAI: AND THAT COMPLETES THE READING OF THE 

22 AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH 

23 SUPERVISORIAL DISTRICT NO. 3. 

24
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1 SUP. YAROSLAVSKY, CHAIRMAN: I HAVE NO PRESENTATIONS. 

2 SUPERVISOR KNABE, DO YOU HAVE ANY PRESENTATIONS? SUPERVISOR 

3 ANTONOVICH? 

4

5 SUP. ANTONOVICH: TODAY WE'RE GOING TO HONOR JOAN WHITENACK FOR 

6 17 YEARS OF VERY FAITHFUL EXECUTIVE SERVICE AS THE EXECUTIVE 

7 DIRECTOR OF THE FOOTHILL UNITY CENTER. THIS IS ONE OF THE 

8 GREAT PUBLIC/PRIVATE PARTNERSHIPS. DURING HER TIME, JOAN HAS 

9 INCREASED THE SERVICE AREAS IN THE SAN GABRIEL VALLEY FROM 

10 THREE CITIES TO 11 CITIES. SHE EXPANDED THE FACILITIES TO 

11 INCLUDE THREE SITES. SHE INCREASED THEIR OPERATING BUDGET FROM 

12 $50,000 A YEAR TO OVER $1.3 MILLION A YEAR. THEY WENT FROM 1 

13 EMPLOYEE TO 20 EMPLOYEES, GENERATING MILLIONS AND MILLIONS OF 

14 DOLLARS IN GRANT MONEY FROM FOUNDATIONS. SHE DEVELOPED VITAL 

15 PROGRAMS, INCLUDING THE ANNUAL THANKSGIVING DISTRIBUTION, THE 

16 BACK-TO-SCHOOL BLAST PROVIDING SCHOOL SUPPLIES AND CLOTHING TO 

17 AN ESTIMATED 2,000 CHILDREN IN THE SAN GABRIEL VALLEY. WORK 

18 EXPERIENCE PROGRAMS HAVE HELPED TRAIN OUR YOUNG PEOPLE TO GET 

19 JOBS. HOME GROCERY DELIVERY TO HOME BOUND PROGRAMS WHICH 

20 PROVIDES DISABLED AND OUR SENIOR CITIZENS IN THE SAN GABRIEL 

21 VALLEY WITH FOOD. SHE'S RECEIVED THE WOMAN AWARD BY THE 

22 CALIFORNIA STATE SENATE, THE 2001 HUNGER FIGHTER AWARD FOR THE 

23 CALIFORNIA HUNGER ACTION COALITION, THE 2004 EXECUTIVE 

24 DIRECTOR OF THE YEAR BY THE PASADENA'S WOMEN IN BUSINESS, AND 

25 THE 2012 APPLE AWARD BY THE SAN GABRIEL VALLEY COMBINED SCHOOL 
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1 DISTRICTS. SHE'S JOINED TODAY BY HER HUSBAND RAY, WHEELER AND 

2 BETTY MCMILLAN, WHO WILL BE TAKING OVER AS THE EXECUTIVE 

3 DIRECTOR OF THE FOOTHILL UNITY CENTER. AND AGAIN, THIS IS A 

4 REAL GOOD PUBLIC/PRIVATE PARTNERSHIP THAT ENGAGES THE ENTIRE 

5 SAN GABRIEL VALLEY TO MEET THE NEEDS OF THEIR CITIZENS. 

6 [APPLAUSE.] 

7

8 JOAN WHITENACK: THANK YOU SO MUCH FOR THIS RECOGNITION. 

9 FOOTHILL UNITY CENTER IS A NONPROFIT THAT IS ALSO A COMMUNITY 

10 ACTION AGENCY FOR THE AREA. SO WE WORK TOGETHER, GOVERNMENT 

11 AND LOCAL PEOPLE. WITHOUT THE HELP AND SUPPORT OF LOCAL 

12 BUSINESSES, ORGANIZATIONS, CHURCHES, TEMPLES, ALL OF THE 

13 ABOVE, FOOTHILL UNITY CENTER WOULDN'T BE ABLE TO DO WHAT IT 

14 DOES. THIS PAST YEAR, WE SERVED OVER 4,200 FAMILIES, OVER 

15 12,000 INDIVIDUALS, AND THAT IS AN UNDUPLICATED NUMBER. EACH 

16 OF THOSE PEOPLE RECEIVED MULTIPLE SERVICES, SO OUR TOTAL 

17 SERVICES WERE -- IT'S BEEN AN AMAZING EXPERIENCE. AND I WISH 

18 THAT EVERYBODY WILL CONTINUE TO SUPPORT FOOTHILL UNITY CENTER 

19 AND LET IT CONTINUE TO GROW AND TO HELP FAMILIES IN CRISIS. 

20 THANK YOU. [APPLAUSE.] 

21

22 SUP. ANTONOVICH: NOW WE HAVE A LITTLE FOUR-MONTH OLD TERRIER 

23 MIX, SMOKY, WHO YOU CAN GET FROM 562-728-4644. AND THIS IS 

24 LITTLE SMOKY. HI, SMOKY. HE'S LOOKING FOR A HOME. SO ANYBODY 

25 LIKE TO ADOPT SMOKY? HE'S A NONSMOKER. 562-728-4644. 
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1

2 SUP. YAROSLAVSKY, CHAIRMAN: I HAVE ONE ADJOURNING MOTION. I 

3 ASK THAT WE ADJOURN IN THE MEMORY OF ROGER HANSON, A RESIDENT 

4 OF MALIBU AND RETIRED MEMBER OF THE L.A. COUNTY FIRE 

5 DEPARTMENT WHO RECENTLY PASSED AWAY UNEXPECTEDLY AT THE AGE OF 

6 66. ROGER WAS A RETIRED FIREFIGHTER SPECIALIST WHO HAD SERVED 

7 IN FIRE STATION 88, BATTALION 5, AND RETIRED IN 1991 AFTER 24 

8 YEARS OF DEDICATED SERVICE TO THE PEOPLE OF THE COUNTY. HE IS 

9 SURVIVED BY HIS MOTHER, KATHERINE MARY STANISLAUS; A SISTER, 

10 GAIL; TWO SONS, CHRISTIAN AND TY; AND EIGHT GRANDCHILDREN, 

11 CALLY, HUNTER, CONNOR, FISHER, EMILY, JACK, MATTHEW, AND 

12 LUCAS. WITHOUT OBJECTION, UNANIMOUS VOTE. LET'S TAKE UP THOSE 

13 WHO HAVE ASKED TO BE HEARD ON MULTIPLE ITEMS. DR. CLAVREUL? 

14 ITEM S-1, 7, 18 AND 19. S-1 IS NOT UP YET. SO COME UP ON 7, 18 

15 AND 19 AND WE'LL CALL YOU BACK UP ON S-1 LATER. ALL RIGHT. 

16 TAKE YOUR TIME. ARNOLD SACHS? ERIC PREVEN? DR. CLAVREUL? 

17

18 DR. GENEVIEVE CLAVREUL: DR. GENEVIEVE CLAVREUL. GOOD MORNING, 

19 BOARD OF SUPERVISORS. 

20

21 SUP. YAROSLAVSKY, CHAIRMAN: GOOD MORNING. 

22

23 DR. GENEVIEVE CLAVREUL: ON ITEM 18 -- I WILL START ACTUALLY 

24 ITEM 7, ON THE ASSESSOR'S OFFICE. YOU KNOW LAST WEEK, I 

25 BROUGHT THE ISSUES THAT THE NOMINATION OF MR. SANTOS KREIMANN 
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1 HAD BEEN DONE IN A CLOSED SESSION. YOU ASSERTED TO ME THAT IT 

2 WAS DONE UNDER AN OPEN SESSION. I REVIEWED BOTH TAPES FROM 

3 LAST WEEK AND THE WEEK BEFORE. I HAVE ALSO REVIEWED THE 

4 CERTIFIED TRANSCRIPT OF THE BOARDS. AND NO WAY THERE IS A TIME 

5 WHERE YOU PUBLICLY ANNOUNCE THAT MR. SANTOS KREIMANN HAD BEEN 

6 APPOINTED. SO I WAS CORRECT. THIS IS A TOTAL VIOLATION OF THE 

7 BROWN ACT. YOU MAY HAVE HAD A PRIVATE MEETING WITH THE PRESS 

8 TO LET THEM KNOW ABOUT THE APPOINTMENT, BUT AT NO TIME IT WAS 

9 DONE IN AN OPEN SESSION. IF IT WAS, THE CERTIFIED TRANSCRIPTS 

10 ARE WRONG AND I KNOW IN THE PAST YOU HAVE STOOD BY YOUR 

11 CERTIFIED TRANSCRIPTS. SO I ONCE AGAIN WILL CHARGE YOU WITH A 

12 VIOLATION OF THE BROWN ACT VIS-A-VIS THE NOMINATION OF SANTOS 

13 KREIMANN. 

14

15 SUP. YAROSLAVSKY, CHAIRMAN: WHICH ITEM ARE YOU SPEAKING TO, 

16 DR. CLAVREUL? 

17

18 DR. GENEVIEVE CLAVREUL: NO. 7. 

19

20 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. 

21

22 DR. GENEVIEVE CLAVREUL: HAVING TO DO WITH THE ASSESSOR BEING 

23 AN ELECTED -- AND THAT'S TOTALLY -- 

24

25 SUP. YAROSLAVSKY, CHAIRMAN: THAT'S FINE. 
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1

2 DR. GENEVIEVE CLAVREUL: -- ON SUBJECT. SO FOR THAT, I WOULD 

3 LIKE VERY MUCH TO KNOW WHEN THAT WAS ANNOUNCED AND TO WHOM. ON 

4 ITEM 18, YOU KNOW, THAT'S WHY KING-DREW WAS CLOSED, SO WE 

5 COULD GIVE ALL THAT MONEY TO THE NON-COUNTY FOR A HOSPITAL. 

6 AND WHEN YOU LOOK THAT, YOU KNOW THE 12 MILLION THEY ARE 

7 GETTING, OF COURSE THEY WERE ALL WANTING TO HAVE IT FROM OUR 

8 CENTER IN THE HOSPITAL, ESPECIALLY CALIFORNIA HOSPITAL. AND 

9 WHEN YOU LOOK AT THE PHYSICIANS WHO ARE STAFFING THIS 

10 HOSPITAL, THOSE ARE THE SAME PHYSICIANS WHO WERE STAFFING 

11 KING-DREW MEDICAL CENTER. SO I REALLY FEEL BAD ABOUT THAT, I 

12 THINK WE NEEDED KING-DREW AND WE NEEDED THE TRAUMA CENTER 

13 CLOSE TO THE AIRPORT. ON ITEM 19, I THINK IT'S NOT VERY WISE 

14 TO GIVE THE COMPANY OLYMPUS A THREE-YEAR CONTRACT WHERE THEY 

15 CAN INCREASE UP TO 40 PERCENT WITHOUT COMING BACK TO THE 

16 BOARD. YOU KNOW, THAT'S AN ISSUE I HAVE CONSTANTLY BROUGHT 

17 BACK. FOR A CONTRACT TO BE ABLE TO BE INCREASED BY 40 PERCENT 

18 WITHOUT COMING BACK TO THIS BOARD SHOULD NOT HAPPEN. ANYWAY, 

19 THANK YOU VERY MUCH FOR YOUR ATTENTION. 

20

21 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. JUST STAND BY. I WANT 

22 TO GET YOU AN ANSWER ON THE ISSUE. ALL RIGHT. DR. CLAVREUL, 

23 THE ITEM ON THE ASSESSOR WAS ON THE -- ORIGINALLY ON THE 

24 AGENDA OF THE BOARD ON JUNE 12 AS ITEM 70-C. IT WAS POSTPONED 

25 FOR A WEEK, TILL JUNE 19, 2012. AND ON THE AGENDA IT WAS ITEM 
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1 69. IT WAS APPROVED I BELIEVE UNANIMOUSLY BY THE BOARD ON JUNE 

2 19 AS ITEM 69. AND IF YOU'D LIKE, WE'LL GET YOU A COPY OF THE 

3 AGENDA. BUT THANK YOU. I JUST WANT TO SAVE YOU THE ANXIETY OF 

4 A BROWN ACT VIOLATION BECAUSE IT WAS VERY MUCH IN PUBLIC 

5 SESSION AND ONLY IN PUBLIC SESSION. MR. PREVEN, YOU'RE NEXT. 

6

7 DR. GENEVIEVE CLAVREUL: IT WAS NOT APPROVED IN PUBLIC. 

8

9 SUP. YAROSLAVSKY, CHAIRMAN: IT WAS APPROVED ON JUNE 19 IN THIS 

10 ROOM IN PUBLIC. I BELIEVE YOU WERE SITTING HERE AT THE TIME. I 

11 CAN'T BE SURE THAT YOU WERE SITTING HERE, BUT I THINK YOU 

12 WERE. 

13

14 DR. GENEVIEVE CLAVREUL: IF IT WAS, IT WOULD BE IN THE 

15 CERTIFIED TRANSCRIPT. IT WAS NOT IN THE CERTIFIED TRANSCRIPT. 

16

17 SUP. YAROSLAVSKY, CHAIRMAN: WELL I'LL HAVE THE BOARD SECRETARY 

18 CHECK THAT OUT. BUT IT WAS APPROVED AND IT'S ON TAPE, VIDEO 

19 AND AUDIO. MR. PREVEN? 

20

21 ERIC PREVEN: YES, MY NAME IS ERIC PREVEN THE COUNTY RESIDENT 

22 FROM DISTRICT 3 AND I AGREE WITH MS. CLAVREUL. 

23

24 SUP. YAROSLAVSKY, CHAIRMAN: OF COURSE YOU DO. 

25
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1 ERIC PREVEN: ITEM S-1 WILL COME UP LATER. ITEM 1 IS MORE 

2 WAIVING OF THE LIMITATION OF LENGTH OF SERVICE REQUIREMENTS BY 

3 THE BOARD. MR. YAROSLAVSKY IS DOING IT, MR. ANTONOVICH, MR. 

4 KNABE. AND I HAVE DIRECTED TO SUPERVISOR MOLINA TO PLEASE 

5 ADDRESS MR. SANTOS KREIMANN SERVING ON THE PICO RIVERA 

6 REDEVELOPMENT DISSOLUTION BOARD. THIS IS NOT PROPER TO ME. HE 

7 IS THE ACTING COUNTY ASSESSOR. PICO RIVERA, AS YOU PROBABLY 

8 KNOW, HAS HAD A LOT OF REDEVELOPMENT OVER THE YEARS. THERE'S 

9 PROBABLY SOME UNFINISHED BUSINESS. AND THIS GUY HAS A 

10 RELATIONSHIP, MAYOR ANTONOVICH, WITH STARBUCKS BECAUSE HE'S 

11 WORKED WITH THEM BOTH AT GRAND AVENUE, I'M SURE HE'S DOING 

12 SOMETHING -- LOOK, LET'S JUST CLEAN IT UP. HE'S A GOOD GUY, 

13 GET HIM OUT, OKAY? ITEM NO. 3, WE NEED -- THIS IS A $7.5 

14 MILLION DOLLAR FACE-LIFT FOR THE JOHN ANSON FORD THEATER. I 

15 SUPPORT IT. OBVIOUSLY, THIS IS AN OLD FACILITY, IT NEEDS A 

16 LITTLE UPGRADE. BUT LIKE WITH THE $3 MILLION RESTROOM UPGRADE 

17 AT THE HOLLYWOOD BOWL, LET'S GET A LITTLE MORE DETAIL, BECAUSE 

18 THIS IS VERY BLANKET, ALL, AND THEN IT SAYS WE'VE GOT LOTS 

19 MORE TO DO LATER. LET'S KNOW WHAT'S BEING DONE SO THE PUBLIC 

20 CAN PAY ATTENTION AND REPORT BACK THAT IT IS HAPPENING 

21 APPROPRIATELY. ITEM NO. 4 IS SUPERVISOR YAROSLAVSKY REACHING 

22 FOR SOME EFFICIENCIES REGARDING VIDEO CONFERENCING. AND 

23 NATURALLY WE ALL SUPPORT THIS. WE ARE VERY MUCH AGAINST 

24 COMPANY CARS FOR COUNTY EMPLOYEES UNLESS IT'S ABSOLUTELY 

25 NEEDED. AND THIS IDEA OF PHASING OUT MAINTENANCE CONTRACTS ON 
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1 COMPANY CARS IN EXCHANGE FOR ENTERPRISE RENT-A-CAR? NOT WHAT 

2 WE WANT. WE WANT EFFICIENCY. AND THANK YOU FOR REACHING FOR 

3 THE VIDEO CONFERENCING THERE. ITEM NO. 45, THANK YOU, 

4 SUPERVISOR KNABE OR WHOEVER, FOR PULLING THAT BACK. THE 

5 SHERIFF'S DEPARTMENT NEEDS TO BE REPORTED ON APPROPRIATELY IN 

6 AUGUST BEFORE WE FINALIZE THAT DECISION MAKING. ANY KIND OF 

7 INAPPROPRIATE EXPENDITURES OF COURSE NEEDS TO BE VETTED 

8 PROPERLY BEFORE WE PUSH THROUGH SOMETHING THAT'S HIGHLY 

9 SUSPICIOUS AND SOUNDS LIKE "GET SMART." AND I'M OF COURSE 

10 REFERRING TO THE SONAR EXPLOSIVE DETECTION DEVICES. WE ALL 

11 TAKE HOMELAND SECURITY VERY SERIOUSLY AND WE ALL WANT FUNDING 

12 WHEN IT'S AN AVAILABLE FOR APPROPRIATE USE. BUT THIS 

13 DEPARTMENT IS CURRENTLY ACTIVELY MIRED IN WHAT APPEARS TO BE A 

14 SCANDAL. I MEAN, I DON'T WANT TO DIRECT YOUR ATTENTION TO 

15 MARCH 27, I BELIEVE IT WAS, 2012, SUPERVISOR YAROSLAVSKY WHEN 

16 YOU REQUESTED THAT WE ROLL UP OUR SLEEVES AND FIND OUT WHAT'S 

17 GOING ON. AND FINALLY ITEM NO. 35, WE NEED SOME REAL OVERSIGHT 

18 HERE. THIS IS A PUBLIC WORKS PROJECT THAT IS 53 PERCENT OVER 

19 ITS ORIGINAL COST. AND THIS ONE IS A STINKER, GUYS. PLEASE GET 

20 SOMEBODY TO INVESTIGATE THIS. THERE'S A MAY 12, 2012 BOARD 

21 ACTION THAT'S REFERRED TO, AND IT'S NOT MY EXPERIENCE THAT THE 

22 BOARD MEETS ON MAY 12. THAT'S A SATURDAY. UNLESS MY CALENDAR 

23 IS OFF HERE, IS IT A LEAP YEAR? I MEAN, COME ON GUYS, THAT'S 

24 NOT APPROPRIATE, NUMBER ONE. NUMBER TWO, THERE'S OVER A 

25 HUNDRED AND SOMETHING THOUSAND DOLLARS IN EXPENDITURES WELL 
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1 OVER THE $10,000 CAP THAT PREEXISTED BOARD APPROVAL OF THIS 

2 $134,000. AND PLUS THE WORK, AS I UNDERSTAND IT, IS DONE. 

3 PEOPLE IN MALIBU HAVE KNOWN THIS WORK TO BE DONE FOR ALMOST A 

4 YEAR AND A HALF. I DON'T KNOW WHAT ELSE TO SAY. ITEM NO. 55-A 

5 IS SUPERVISOR YAROSLAVSKY APPROPRIATELY LOOKING INTO THE -- 

6 ONE SECOND THE CLIMATE CHANGE REPORT BY U.C.L.A., WHICH WE ALL 

7 ARE EXCITED TO SEE. BUT IT WAS NOT ATTACHED. SO IF I COULD GET 

8 A COPY OF IT. THANK YOU. 

9

10 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MR. SACHS AND MR. 

11 SNELLS? DO YOU WANT TO COME DOWN? 

12

13 ARNOLD SACHS: YES, THANK YOU, GOOD MORNING. ARNOLD SACHS. I 

14 HELD ITEM, LET'S SEE, ITEM 1-D BECAUSE WE HAVE TO TELL BECAUSE 

15 THEY'RE NOT PUT ON THE BULLETIN BOARD, THE C.D.C. WOULD THIS 

16 ALSO MEAN THAT THE COMMUNITY DEVELOPMENT COMMISSION, THAT THE 

17 OVERSIGHT, THE SUCCESSOR AGENCY TO THE REDEVELOPMENT AGENCY OF 

18 LOS ANGELES, WHICH YOU ARE NOW A PART OF ACCORDING TO WHAT WAS 

19 POSTED ON OUTSIDE BULLETIN BOARD IS ALSO MEETING AT THIS TIME? 

20 I MEAN, I KNOW YOU CALL THESE MEETINGS AND THEY ALL KIND OF 

21 LIKE FLOW TOGETHER. SO IS THE OVERSIGHT COMMITTEE MEETING AT 

22 THIS TIME ALSO? IN ADDITION, YOU'VE DOCUMENTED 4,180 WORTH OF 

23 C.D.B.G. FUNDS. NOW AS I POINTED OUT BACK IN NOVEMBER OR MAY 

24 OF 2011, WHEN YOU HAD YOUR 37TH YEAR PROGRAM, YOU HAD OVER 13 

25 MILLION, ALMOST $14 MILLION IN UNEXPENDED C.D.B.G. FUNDS FROM 
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1 PRIOR YEARS. SO $4,180 FOR SOUNDPROOFING IS GOING TO PUT A 

2 DENT IN THAT BUDGET. I THINK YOU'VE COVERED THE COST OF PAPER 

3 CLIPS. ITEM NO. 1, YOU'RE MAKING MORE WAIVERS ON TERM 

4 LIMITATIONS FOR YOUR APPOINTEES. DOESN'T TERM LIMITS MEAN 

5 ANYTHING? I GUESS NOT. ITEM NO. 9 REFERS TO SOME SCHOOL GRANTS 

6 FOR SOME AFTER SCHOOL PROGRAMS. AND I ALSO HELD 10 BECAUSE 

7 YOU'RE ESTABLISHING A CONTRACT, $1.2 MILLION, TO CREATE AND 

8 MAINTAIN JOBS IN UNDEVELOPED -- UNDERDEVELOPED AREAS IN L.A. 

9 COUNTY. WELL, THAT COMES TO LIKE $250, $300,000, NOT EVEN 

10 $300,000 PER DISTRICT. AND I WAS WONDERING, YOU MIGHT HAVE 

11 READ, MAYBE NOT, ABOUT THE L.A.U.S.D. CUTTING ADULT SCHOOL AND 

12 THE PROGRAMS THAT ADULT SCHOOL PROVIDES. AND I WAS THINKING: 

13 WELL SOME PEOPLE HAVE WRITTEN TO SAY THAT THOSE PROGRAMS 

14 PROVIDE JOB TRAINING AND HELP PEOPLE TO GET NEW JOBS. SO IS 

15 THERE A CORRELATION BETWEEN HAVING SOME MONEY PROVIDED TO 

16 ADULT SCHOOL AND THE FACT THAT L.A.U.S.D. IS GOING TO CUT 

17 THOSE PROGRAMS BECAUSE THE BUDGET CONSTRAINTS? AND MAYBE YOU'D 

18 WRITE A LETTER TO SOMEBODY. YOU'RE ALWAYS GOOD AT WRITING 

19 LETTERS. I HELD ITEM 15 BECAUSE YOU'RE DEALING WITH THE 

20 CALABASAS LANDFILL. AND I WAS JUST GOING TO SAY WHY DON'T YOU 

21 USE THE SAME PROGRAM THAT YOU DID AT THE SUNSHINE CANYON 

22 LANDFILL, HOW YOU ELIMINATED 6,600 TONS OF REFUGE JUST BY THE 

23 BLINK OF AN EYE THAT'S NOT ACCOUNTED FOR ANYWHERE IN PUBLIC 

24 DOCUMENTATION. AND SPEAKING OF DOCUMENTATION, THE VIDEOTAPES 

25 AND ALL THE OTHER STUFF LIKE YOU DID ON ITEM NO. 7, 
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1 SUPERVISOR, THAT WAS DOCUMENTED IN YOUR AGENDA AND IT WAS 

2 JUST, OH, THAT WAS SOIL COVERAGE. AND THAT GOES BACK TO THE 

3 ANTONOVICH RESOLUTION. LEGISLATIVE ADVOCATES TO SEEK SPONSORS? 

4 I HAVE A DOCUMENTED LAND GRANT, BY THE WAY. 

5

6 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU, MR. SACHS. 

7

8 ARNOLD SACHS: WHAT DOES THAT MEAN? 

9

10 SUP. YAROSLAVSKY, CHAIRMAN: YOUR TIME IS UP. 

11

12 ARNOLD SACHS: YEAH, THAT'S WHAT IT MEANS. TIME IS UP. 

13

14 SUP. YAROSLAVSKY, CHAIRMAN: MR. SNELL. 

15

16 E.T. SNELL: E.T. SNELL, CLOWN COMMUNITY ACTIVIST AT 

17 WWW.ETSNELL.COM. COUNTY SUPERVISORS, I'M HERE TO SPEAK ON 45 

18 DIFFERENT ITEMS TODAY, KIND OF TOUGH IN THREE MINUTES. BUT I'M 

19 GOING TO ATTEMPT TO DO IT. LET AUTO START OFF WITH NO. 7, 

20 WE'LL JUMP AROUND A LITTLE BIT. YOU KNOW OCTOBER 19, 2010, I 

21 HAD A 3-INCH STACK OF PAPERWORK ON MR. NOGUEZ ON HIS -- WASN'T 

22 HIS REAL NAME. HE HAD MARRIED HIS COUSIN, NEVER GOT A DIVORCE 

23 AND MARRIED SOME DUDE. BUT I HAD ALL THIS PAPERWORK. I WAS 

24 ARRESTED AND PUT A MILLION DOLLARS BAIL BEFORE I COULD SPEAK 

25 ON IT. BUT MAYBE I CAN FINISH SPEAKING ON IT TODAY WHERE I 
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1 LEFT OFF AT. YOU KNOW, WHAT I DON'T UNDERSTAND, SEE, HOW'S 

2 DIRTY DAVE -- PUBLIC INTEGRITY GOING TO PUT ME IN PRISON ON 

3 PHONY CHARGES GOING TO BE ABLE TO PROSECUTE NOGUEZ? FIRST OFF 

4 YOU GOT KNABE'S SON -- 

5

6 SUP. YAROSLAVSKY, CHAIRMAN: MR. SNELL, YOU'VE GOT TO STICK TO 

7 THE AGENDA ITEMS YOU'VE ASKED TO BE HEARD ON. 

8

9 E.T. SNELL: AREN'T WE ON NO. 7, THE ASSESSOR? I'M SPEAKING 

10 ABOUT THAT. 

11

12 SUP. YAROSLAVSKY, CHAIRMAN: I DIDN'T HEAR YOU SAY MUCH ABOUT 

13 ASSESSOR. GO AHEAD. 

14

15 E.T. SNELL: YEAH. I'M SPEAKING ABOUT JOHN NOGUEZ, KNABE'S SON 

16 WAS HIS CAMPAIGN MANAGER. SO HE'S ALL TIED TO ALL THIS 

17 CORRUPTION WITH YOU GUYS. A COUPLE OF YOU GUYS ENDORSED HIM. 

18 SO IT'S REALLY GOING TO BE HARD TO PROSECUTE HIM. AND WHAT I 

19 DON'T UNDERSTAND IS PROPERTY VALUES IN THE CLOWNY OF LOS 

20 ANGELES HAVE DECREASED 30 TO 65 PERCENT. THIS GUY ONLY GOT A 

21 27 PERCENT KICKBACK. THAT'S NOTHING. BUT WHAT IT IS IS ON ALL 

22 OF THEM YOU GUYS ARE ONLY GIVING 16 PERCENT. HOW CAN YOU GIVE 

23 16 PERCENT -- THIS IS WHAT I DON'T UNDERSTAND -- WHEN THE 

24 PROPERTY VALUES HAVE DROPPED 30 TO 65 PERCENT? IT SEEMS LIKE 

25 YOU SHOULD BE GIVING 30 TO 65 PERCENT DECREASE OF ASSESSED 
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1 VALUE? SO WITH THAT BEING SAID AND NOW ANTONOVICH WANTS TO 

2 TAKE ANOTHER BITE OF THE APPLE AND JUST SAY WELL LET'S NOT 

3 EVEN ELECT THE GUY. YOU GUYS HAVE ALREADY GOT IT GOING ON 

4 ANYWAY. I MEAN IT'S SAD. CS-1, THE COUNTY JAIL. WOW, WHEN I 

5 WAS IN THERE FOR NINE MONTHS, FOLKS, I WAS THERE. DO YOU THINK 

6 THOSE CONCENTRATION CAMPS WERE SOMETHING, MR. FUJIOKA? YOU GOT 

7 TO GO TAKE A TOUR OF THAT PLACE. I MEAN SHOWERS EVERY SIX 

8 WEEKS IF YOU WERE LUCKY IN THE 2,000 AND 3,000 FLOOR. SOUPS 

9 THAT YOU BUY FOR 25 CENTS IN THE PENITENTIARY ARE A BUCK AND A 

10 QUARTER THERE. AND THE BRUTALITY? MAN, DON'T GET THOSE GUARDS 

11 GOING. DO NOT, NOT RUN BACK FROM THE SHOWER WHEN THEY GIVE YOU 

12 30 SECONDS TO A MINUTE AND A HALF WITH THE HOT WATER RUNNING. 

13 AND THE CORRUPTION THAT GOES ON IN THE COUNTY JAIL GOES ON AND 

14 ON AND ON. MENTAL HEALTH ISSUES? THERE WAS A TIME WHERE I 

15 NEEDED SOME MEDICATION WHERE THEY WERE GETTING READY TO THROW 

16 THAT 35 YEARS AT ME ON THEM PHONY CHARGES. AND DO YOU KNOW 

17 WHAT? IT WASN'T AVAILABLE TO ME. YOUR MENTAL HEALTH IS A JOKE 

18 OVER THERE. IT'S CRAZY WHAT'S GOING ON IN L.A. CLOWN-TY JAIL. 

19 AND IT GOES ON AND ON AND ON. I SAW MANY -- AND THE GUARDS 

20 WERE INSTIGATING FIGHTS. NOW WE'LL RUN ON TO -- 

21

22 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. YOUR TIME IS UP. WE 

23 HAVE OTHER PEOPLE WANT TO BE HEARD ON THOSE ITEMS, RIGHT? 

24

25 CLERK SACHI HAMAI: RIGHT. 
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1

2 SUP. YAROSLAVSKY, CHAIRMAN: YES. 

3

4 CLERK SACHI HAMAI: SO WE HAVE A NUMBER OF ITEMS FOR APPROVAL. 

5 SO ITEM NO. 1-D, 2-D, 1, AND THEN ITEM NO. 2, SUPERVISOR 

6 RIDLEY-THOMAS AND SUPERVISOR ANTONOVICH ABSTAIN. 

7

8 SUP. YAROSLAVSKY, CHAIRMAN: SO I'LL MOVE AND KNABE SECONDS ON 

9 ITEM NO. 2. IT IS APPROVED WITH ANTONOVICH AND RIDLEY-THOMAS 

10 ABSTAINING. 

11

12 CLERK SACHI HAMAI: SO AGAIN 1-D, 2-D, 1, 3. AND THEN WE'RE AT 

13 ITEM NO. 7, SUPERVISOR MOLINA AND SUPERVISOR YAROSLAVSKY VOTE 

14 NO. 

15

16 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. SO MOVED BY ANTONOVICH, 

17 SECONDED BY KNABE. CALL THE ROLL ON THAT ONE. THIS IS ON THE 

18 ADVISORY REFERENDUM ON THE NOVEMBER BALLOT DEALING WITH THE 

19 ASSESSOR. 

20

21 CLERK SACHI HAMAI: SUPERVISOR MOLINA? SUPERVISOR RIDLEY-

22 THOMAS? 

23

24 SUP. RIDLEY-THOMAS: AYE. 

25
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1 CLERK SACHI HAMAI: SUPERVISOR KNABE? 

2

3 SUP. KNABE: AYE. 

4

5 CLERK SACHI HAMAI: SUPERVISOR ANTONOVICH? 

6

7 SUP. ANTONOVICH: AYE. 

8

9 CLERK SACHI HAMAI: SUPERVISOR YAROSLAVSKY? 

10

11 SUP. YAROSLAVSKY, CHAIRMAN: NO. THAT IS APPROVED. ALL RIGHT. 

12 NEXT ITEM. SO KEEP GOING. 

13

14 CLERK SACHI HAMAI: ITEM NO. 9, ITEM NO. 11, 12. ON ITEM NO. 13 

15 AND 14, THOSE WILL BE CONTINUED ONE WEEK. ITEM 15, 16, 17, 18 

16 AND 19, 28, 29, 30, 31, 33, 35, 36, 37, 39 WILL BE REFERRED 

17 BACK. 40, 44 WILL BE CONTINUED ONE WEEK, AND 45 AND 48 WILL BE 

18 CONTINUED ONE WEEK, AND THEN ITEM NO. 55-A AND 55-B. OKAY. SO 

19 WE'LL HOLD 55-A RIGHT NOW. SO IF I COULD GET THE MOTION ON THE 

20 OTHERS. RIGHT. 

21

22 SUP. YAROSLAVSKY, CHAIRMAN: MOVED BY ANTONOVICH. SECONDED BY 

23 MOLINA; WITHOUT OBJECTION, UNANIMOUS VOTE. 

24

25 CLERK SACHI HAMAI: THANK YOU. 
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1

2 SUP. YAROSLAVSKY, CHAIRMAN: I'D LIKE TO MAKE A COUPLE OF OTHER 

3 ADJOURNING MOTIONS. I'D LIKE TO ASK THE BOARD TO ADJOURN IN 

4 THE MEMORY OF A FORMER PRIME MINISTER ISRAELI PRIME MINISTER, 

5 YITZHAK SHAMIR, WHO PASSED AWAY OVER THE WEEKEND. ALL MEMBERS. 

6 AND ALSO THIS MORNING THE NEWS HAS COME TO US THAT ANDY 

7 GRIFFITH HAS DIED IN HIS HOME IN NORTH CAROLINA. AND ALL 

8 MEMBERS ON ANDY GRIFFITH. HE WAS A GREAT ACTOR AND A GREAT 

9 HUMAN BEING. WITHOUT OBJECTION, UNANIMOUS VOTE. CAN WE TAKE UP 

10 ITEM 54? AND ITEM 26, THANK YOU. IS THE STAFF HERE? OH, WE 

11 HAVE ONE SPEAKER, THAT'S RIGHT. TWO SPEAKERS. JOYCE DILLARD? 

12 AND MICHAEL LEWIS? AND CAN WE GET THE STAFF UP HERE? IS PUBLIC 

13 WORKS HERE? 

14

15 MICHAEL LEWIS: MR. CHAIRMAN, MEMBERS OF THE BOARD, MY NAME IS 

16 MICHAEL LEWIS, I'M HERE ON BEHALF OF THE CONSTRUCTION INDUSTRY 

17 COALITION ON WATER QUALITY. AND WE DELIVERED A COMMENT LETTER 

18 ON THIS PROPOSAL TO YOUR OFFICES YESTERDAY. I BROUGHT SOME 

19 ADDITIONAL COPIES. AND IF I CAN, I'D JUST LIKE TO RECITE SOME 

20 OF THE CONCERNS THAT WE HAVE ABOUT THE PROPOSAL. FIRST OF ALL, 

21 LET ME SAY THAT OUR ORGANIZATION HAS BEEN AROUND REPRESENTING 

22 THE CONSTRUCTION INDUSTRY ON WATER QUALITY MATTERS FOR A DOZEN 

23 YEARS. WE SUPPORT A REGIONAL SOLUTIONS APPROACH TO DEALING 

24 WITH STORM WATER, AND WE AGREE THAT WE NEED A SPECIFIC SOURCE 

25 OF REVENUE FOR STORM WATER CLEANUP. AND WE ARE ADVOCATES FOR 
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1 THAT. I THINK IN TERMS OF THE DETAILS, WE'D LIKE TO SEE THIS 

2 PROPOSAL INCLUDE A PROVISION FOR THE EXEMPTION FOR ON-SITE 

3 TREATMENT FOR A PROPERTY OWNER WHO CHOOSES OR OPTS UNDER THE 

4 CURRENT REGIMEN TO PROVIDE ALL OF THE TREATMENT ON SITE. THEY 

5 SHOULDN'T HAVE TO PAY THAT FEE. ON THE OTHER HAND, THEY SHOULD 

6 ALSO BE ALLOWED TO CONTRIBUTE THE VALUE OF THAT, WE BELIEVE, 

7 TO AN OFFSITE TREATMENT OR A REGIONAL TREATMENT DOWN STREAM IF 

8 THAT WILL DO MORE FOR CLEANING UP THE WATER IN THE 

9 NEIGHBORHOOD. WE'D LIKE TO SEE SOME VERY CLEAR, COST-

10 EFFECTIVENESS MEASURES ESTABLISHED FOR THIS MEASURE AND FOR 

11 THE PROJECTS THAT ARE GOING TO BE FUNDED BY IT. WE'D LIKE TO 

12 SEE THE CAP OF 10 PERCENT FOR ADMINISTRATIVE FEES LOWERED. IF 

13 YOU DO THE CALCULATION AT 10 PERCENT, THAT'S ABOUT $54 MILLION 

14 OF THIS 275 THAT COULD BE USED FOR ADMINISTRATION, AND THAT'S 

15 A PRETTY SIZABLE BUREAUCRACY. WE'D LIKE TO SEE THE CITY 

16 PROJECTS INCLUDED IN THE WAG PLANS. THEY REPRESENT 40 PERCENT 

17 OF THE EXPENDITURES. AND IF YOU'RE GOING TO HAVE A PLAN, IT 

18 OUGHT TO INCLUDE ALL OF THE PROJECTS THAT ARE GOING TO BE 

19 FUNDED BY THE PROPOSAL, NOT JUST THE 50 PERCENT FUNDED BY THE 

20 WAG. WE'D LIKE TO SEE A MAINTENANCE OF EFFORT PROVISION 

21 INCLUDED THAT WOULD AVOID SIGNIFICANT TRANSFER OF EXISTING 

22 ACTIVITIES TO BE FINANCED BY THIS MEASURE. STREET SWEEPING IS 

23 AN EXAMPLE. THERE'S PROBABLY $75 MILLION WORTH OF STREET 

24 SWEEPING DONE IN THE REGION NOW, AND THESE FUNDS COULD BE USED 

25 FOR THAT PURPOSE IF THE CITIES OPTED TO. AND WE THINK THAT 
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1 THAT KIND OF TRANSFER OUGHT TO BE AVOIDED UNDER MAINTENANCE OF 

2 EFFORT. WE THINK THAT MORE OF THE WATER PROVIDERS SHOULD BE 

3 INCLUDED IN THE WAGS. FRANKLY, OUR EXPERIENCE IS THAT THEY'RE 

4 WAY AHEAD OF MOST OF THE AGENCIES IN TERMS OF PLANNING FOR 

5 WHERE THEY CAN INFILTRATE WATER, WHERE THEY CAN MANAGE STORM 

6 WATER, WHERE IT'S BEST USED, WHERE THEY DON'T WANT IT. AND, 

7 FRANKLY, THEY HAVE THE MONEY TO ASSIST IN FUNDING SOME OF 

8 THESE PROJECTS. WE'D LIKE TO SEE 80 PERCENT OF THESE FUNDS BE 

9 COMMITTED TO DESIGN AND CONSTRUCTION. AFTER ALL, WE'RE 

10 PROBABLY GOING TO NEED AN ENORMOUS NUMBER OF FACILITIES AND 

11 ADAPTATION OF THE CURRENT FLOOD CONTROL SYSTEM IN ORDER TO 

12 MANAGE THIS STORM WATER. WE'VE GOT A QUESTION ABOUT THE QUORUM 

13 REQUIREMENTS. WE'VE PROPOSED A MODIFICATION TO THE DEFINITION 

14 OF A REGIONAL PROJECT. AND WE'D LIKE TO SEE A SUNSET INCLUDED 

15 AT SOME POINT TO CAUSE A REEVALUATION OF THIS PROPOSAL. 

16

17 SUP. YAROSLAVSKY, CHAIRMAN: OKAY, THANK YOU. MS. DILLARD? 

18

19 JOYCE DILLARD: -- PROP 218 WHERE IT REALLY DOESN'T FIT INTO 

20 THE CRITERIA, I STILL DO, BUT I WANT TO GO INTO OTHER THINGS. 

21 YOU HAVE EMINENT DOMAIN POWERS PROVIDED BY A.B. 2554. THIS 

22 ELECTION IS GOING TO PUBLIC WORKS, IT'S NOT GOING INTO ANY 

23 ELECTION DIVISION. STORM WATER IN THE STATE DEFINITION OF 

24 RECYCLED WATER IS NOT IN IT, FRANKLY. WASTE WATER IS. SO IN 

25 ESSENCE YOU'RE CREATING PUBLIC HEALTH GUIDELINES. YOU DID FOR 
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1 THE CITY OF L.A., BASICALLY IN THIS RAIN WATER HARVESTING, 

2 DONE IN PRIVATE, NOT IN THE PUBLIC FORUM. YOU HAVE BUILDING 

3 AND SAFETY, AND HERE THEY'RE NOT THE ONLY ONE THAT COVERS 

4 PROPERTY, BUREAU OF CONTRACT ADMINISTRATION. YOU ARE CREATING 

5 A LIABILITY FOR YOURSELF BY DOING THIS, A LIABILITY YOU REALLY 

6 HAVEN'T ADDRESSED. THE PUBLIC NEEDS BUY-IN INTO WATER. THEY 

7 NEED BUY-IN IN THEIR LIVES, IN THEIR HOMES, IN THEIR 

8 BACKYARDS. AND THIS WHOLE ORDINANCE HAS NO PLANNING AROUND IT 

9 FOR THAT. IT'S DONE FOR BIG PROJECTS, FRANKLY. YOU HAVEN'T 

10 IDENTIFIED SOURCE POINTS. NON-SOURCE POINTS YOU WANT TO TAKE 

11 FROM THE TAXPAYER FOREVER AND FOREVER WITH NO SUNSET? YOU 

12 THAT'S WHAT YOU'RE DOING. YOU NEED TO START IDENTIFYING SOURCE 

13 POINTS AND MAKING THEM RESPONSIBLE. THIS IS PART OF THE 

14 PROBLEM. WE HAVE FRACKING NOW, THAT'S A STATE AGENCY OVER 

15 THAT, D.O.G.G.R., THEY'VE DONE NO LICENSING, NOTHING. BUT THAT 

16 FRACKING FLUID, WHICH WE DON'T KNOW WHAT IT CONSISTS OF, GOES 

17 INTO THE WATER AND PRESENTS PROBLEMS. YOU HAVE NO FINANCIAL 

18 ASSESSMENT OF THIS. IT'S GOING TO BE BILLIONS AND BILLIONS OF 

19 DOLLARS FOREVER. YOU HAVE NO BASELINE TO BEGIN WITH WITH WATER 

20 QUALITY, YET THIS IS THE WATER QUALITY ASSESSMENT. IT'S MADE 

21 AND LOOKED LIKE MITIGATION BANKING BECAUSE THAT SEEMS TO BE 

22 THE TREND WHICH AFFECTS A LOT OF PEOPLE, AND IT'S REALLY NOT 

23 PLANNED WELL ESPECIALLY WITH THE SEDIMENT PLAN THAT NEEDS TO 

24 BE REVISED TO THE MODERN DAY INSTEAD OF 100 YEARS AGO. PART OF 

25 THE PROBLEM I SEE IN THIS IS THAT IF YOU GET THIS GOING WITH 
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1 YOUR WATERSHED GROUPS, WHICH I TOTALLY OBJECT TO THE WAY IT'S 

2 HANDLED, IN THE CITY OF L.A., WE HAVE THE DEPARTMENT OF WATER 

3 AND POWER WHO CONTROLS WATER ASSETS, STORM WATER SANITATION. 

4 NOW WE'VE GOT A PROBLEM BECAUSE IF THE STORM WATER AND URBAN 

5 RUNOFF BECOME AN ASSET, THERE'S A JURISDICTIONAL PROBLEM. SO I 

6 JUST SEE THIS AS A BAD MOVE WITHOUT THE PLANNING. AND I WISH 

7 YOU WOULD SPEND THE TIME AND ENERGY TO DO THE PLANNING ON IT. 

8 I UNDERSTAND THE IMPORTANCE OF THIS BECAUSE I SIT IN A LOT OF 

9 WATER MEETINGS AS A PUBLIC PERSON AND HAVE A LEARNING CURVE ON 

10 THIS, BUT THIS IS JUST FOR CONTRACTS. IT'S NOT TO SOLVE THE 

11 PROBLEM. IT'S NOT TO GET PEOPLE ENGAGED. AND IT'S DONE IN A 

12 REALLY BACKHANDED WAY. AND, AGAIN, HOW MUCH LIABILITY CAN THE 

13 COUNTY TAKE IN THE FUTURE? BECAUSE THERE WILL BE PROBLEMS. 

14 WE'VE ALREADY HAD QUARANTINE, WE'VE ALREADY SEEN IN ISSUES OF 

15 PUBLIC HEALTH WHERE PERMITS WERE NOT ISSUED AND QUARANTINES 

16 NOT DONE. THERE'S JUST A LOT OF PUBLIC HEALTH ISSUES THAT 

17 AREN'T EVEN ADDRESSED IN THIS. THANK YOU. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. PEDRO SALCIDO AND JEFF 

20 MALONEY? 

21

22 PEDRO SALCIDO: GOOD MORNING. PEDRO SALCIDO WITH LOS ANGELES 

23 UNIFIED SCHOOL DISTRICT. ABOUT TWO WEEKS AGO WE SUBMITTED OUR 

24 CONCERNS WITH THE PROPOSED ASSESSMENT, AND WE JUST WANTED TO 

25 HIGHLIGHT THAT. THE DEPARTMENT OF PUBLIC WORKS HAS ACTUALLY 
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1 BEEN VERY PROACTIVE AND REACHING OUT TO OUR OFFICE AND TO 

2 MULTIPLE DISTRICTS WITHIN L.A. COUNTY TO TRY TO RESOLVE SOME 

3 OF THE FISCAL IMPACTS THAT THESE PROPOSED FEE ASSESSMENTS 

4 WOULD HAVE ON OUR PARCELS. L.A. UNIFIED HAS AN ESTIMATED 3,500 

5 PARCELS WITHIN L.A. COUNTY. AND POTENTIALLY PRELIMINARY 

6 ESTIMATES PROVIDED BY THE DEPARTMENT OF PUBLIC WORKS IS ABOUT 

7 $4.8 MILLION GENERAL FUND IMPACT TO OUR SCHOOL DISTRICT. IN A 

8 TIME WE'RE FACING A FISCAL CRISIS AT THE STATE AND AT THE 

9 LOCAL LEVEL AND HAVE MADE SIGNIFICANT CUTS TO CORE 

10 INSTRUCTIONAL SUPPORT TO OUR CHILDREN, THE CHILDREN THAT WE 

11 SERVE, THIS IS A MAJOR CONCERN TO US. SO WE HOPE THAT THERE IS 

12 A COMMITMENT TO CONTINUE TO WORK TOWARDS A SOLUTION. AND I 

13 JUST WANTED TO STATE THESE CONCERNS FOR YOU ALL. LONG BEACH 

14 UNIFIED HAS SUBMITTED A LETTER OF CONCERN WITH US JOINTLY. SO 

15 I APPRECIATE THE DEPARTMENT OF PUBLIC WORKS AND BOARD MEMBER 

16 RIDLEY-THOMAS'S OFFICE FOR BEING ENGAGED IN HAVING OPEN 

17 CONVERSATION WITH US. THANK YOU. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU, MR. SALCIDO. MR. 

20 MALONEY? 

21

22 JEFF MALONEY: YES, GOOD MORNING. MY NAME IS JEFF MALONEY. I'M 

23 STAFF COUNSEL FOR THE MOUNTAINS RECREATION CONSERVATION 

24 AUTHORITY, THE M.R.C.A. ON BEHALF OF THE M.R.C.A., AND THE 

25 SANTA MONICA MOUNTAINS CONSERVANCY I'D JUST LIKE TO EXPRESS 
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1 OUR SUPPORT FOR THE CLEAN WATER, CLEAN BEACHES MEASURE BEFORE 

2 YOU TODAY. THE CONSERVANCY AND THE M.R.C.A. HAVE REVIEWED THE 

3 MEASURE AND ARE ENTHUSIASTIC ABOUT ITS CONTENTS. THE MEASURE 

4 ADDRESSES A MAJOR REGIONAL PROBLEM IN A COMPREHENSIVE MANNER 

5 THAT PROVIDES A BALANCED APPROACH INCORPORATING APPROPRIATE 

6 GREEN SOLUTIONS. IT ALSO PROVIDES A PLATFORM FOR MULTIPLE 

7 BENEFIT PROJECTS THAT WILL DISTRIBUTE BENEFITS WIDELY, 

8 INCLUDING AND ESPECIALLY THE SCHOOLS AND THE CHILDREN THEY 

9 SERVE. IMPORTANTLY, THE MEASURE ALSO INVOLVES THE APPROPRIATE 

10 STAKEHOLDERS IN THE WATERSHED AUTHORITY GROUPS, INCLUDING THE 

11 RELEVANT CONSERVANCIES. BOTH THE CONSERVANCY AND THE M.R.C.A. 

12 LOOK FORWARD TO CONTINUING TO WORK WITH THE FLOOD CONTROL 

13 DISTRICT AND THE BOARD OF SUPERVISORS AS THIS MEASURE 

14 CONTINUES TO PROCESS. THANK YOU FOR YOUR TIME AND THANK YOU 

15 FOR YOUR WORK ON THIS IMPORTANT MEASURE. 

16

17 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. IF THERE ARE NO OTHER 

18 PEOPLE WHO WISH TO BE HEARD, THE PUBLIC HEARING IS CLOSED. 

19 HANG ON. CAN I ASK THE STAFF TO MAKE A BRIEF PRESENTATION ON 

20 THIS? 

21

22 GAIL FARBER: GOOD MORNING, THANK YOU SUPERVISOR ZEV 

23 YAROSLAVSKY AND THE BOARD. WE'RE RECOMMENDING THIS MORNING 

24 BOARD AUTHORIZATION TODAY FOR THE FLOOD CONTROL DISTRICT TO 

25 INITIATE THE PROCESS FOR A PROTEST HEARING IN CONFORMANCE WITH 
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1 THE PROVISIONS OF PROP 218 RELATED TO THE POTENTIAL 

2 IMPLEMENTATION OF A FEE TO FUND CLEAN WATER, CLEAN BEACHES AND 

3 WATER QUALITY PROGRAM. IT IS OUR PROFESSIONAL JUDGMENT THAT 

4 THE PROPOSED CLEAN WATER, CLEAN BEACHES WATER QUALITY PROGRAM 

5 IS I SCIENTIFICALLY SOUND AND WILL EFFECTIVELY ADDRESS THE 

6 DEGRADATION OF WATER QUALITY WITHIN SURFACE WATERS WITHIN OUR 

7 COUNTY WATERWAYS, WHILE PROVIDING PARTICIPATING MUNICIPALITIES 

8 WITH A SUSTAINABLE SOURCE OF FUNDING FOR WATER QUALITY 

9 IMPROVEMENTS. WE'VE BEEN BEFORE YOU TODAY TO DISCUSS THE 

10 DETAILS OF THE PROGRAM, BUT ASSISTANT DIRECTOR MARK PESTRELLA 

11 OF THE STAFF IS HERE TO ADDRESS ANY FURTHER QUESTIONS THAT YOU 

12 OR THE PUBLIC HAS THIS MORNING. 

13

14 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU, MS. FARBER. DID YOU 

15 WANT TO ADD ANYTHING MR. PESTRELLA AT THIS POINT? 

16

17 MARK PESTRELLA: NO, SUPERVISORS. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: I HAVE A COUPLE OF QUESTIONS. 

20 NUMBER 1, IF AND WHEN WE EVER GET TO THE VOTE BY MAIL BALLOTS 

21 SITUATION, WHO IS RESPONSIBLE FOR TABULATING THE VOTE? 

22

23 MARK PESTRELLA: WE HAVE A CONTRACTOR, SUPERVISOR, THAT WOULD 

24 BE RESPONSIBLE FOR TABULATING THE VOTE. 

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: WHO'S THE CONTRACTOR? 

2

3 MARK PESTRELLA: K.[&] H. PRINTERS AND LITHOGRAPH. 

4

5 SUP. YAROSLAVSKY, CHAIRMAN: I GUESS MY QUESTION IS -- 

6

7 MARK PESTRELLA: IF THE BOARD APPROVES THAT CONTRACT WHICH IS 

8 BEFORE YOU TODAY. 

9

10 SUP. YAROSLAVSKY, CHAIRMAN: I UNDERSTAND. BUT ONE AT A TIME. 

11 WHY WOULDN'T YOU ASK THE DEPARTMENT OF -- THE REGISTRAR 

12 RECORDER'S OFFICE TO TABULATE THE VOTE? 

13

14 MARK PESTRELLA: WE WORKED WITH REGISTRAR-RECORDER CLOSELY ON 

15 THIS ISSUE, AND WE WERE -- DIRECTOR DEAN LOGAN ACTUALLY 

16 REPORTED TO US THAT THE REGISTRAR-RECORDER'S OFFICE IS REALLY 

17 NOT SET UP TO DO THIS TYPE OF ELECTION, A MAIL-OUT BALLOT. BUT 

18 HAS LOOKED OVER THE METHOD WHICH WE ARE PROPOSING AND IS 

19 ENDORSING THAT METHOD. SETTING UP TO DO THAT, THE COST TO SET 

20 IT UP WAS ACTUALLY MORE EFFICIENT TO USE A VENDOR TO DO THAT. 

21

22 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. WOULD IT BE POSSIBLE 

23 FOR THE REGISTRAR-RECORDER TO OVERSEE THE WORK OF THE VENDOR? 

24

25 MARK PESTRELLA: YES, WE EXPECT THAT WILL HAPPEN. 
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1

2 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. I HAVE A MOTION I WANT TO 

3 READ IN A MOMENT, BUT THAT WOULD BE ONE OF THE THINGS THAT IS 

4 NOT INCLUDED IN IT AT THE PRESENT TIME, BUT ONE OF THE MEMBERS 

5 OF THE PUBLIC WHO TESTIFIED PIQUED MY INTEREST ON THIS, SO I 

6 WOULD LIKE TO HAVE IN THE MOTION THAT THE REGISTRAR-RECORDER 

7 BE TASKED WITH THE RESPONSIBILITY OF OVERSEEING THE TABULATION 

8 PIECE AND THAT THE CONTRACTOR AGREE TO THAT PRIOR TO ENTERING 

9 INTO THAT CONTRACT. I THINK IT'S IMPORTANT THAT THERE BE NO 

10 APPEARANCE OF CONFLICT. BECAUSE YOU GUYS ARE THE -- PUBLIC 

11 WORKS IS THE PRINCIPAL BENEFICIARY OF IT AS THE DEPARTMENT AND 

12 THE CONTRACTORS WORKING FOR YOU, THE COUNTY THROUGH YOU. SO I 

13 THINK THE REGISTRAR-RECORDER WOULD BE AN IMPORTANT ELEMENT IN 

14 THAT. SO THAT WOULD BE ONE OF MY REQUESTS. THE OTHER ONE IS 

15 JUST TO BE CLEAR. IT'S NOW JULY 3. ARE YOU OF THE BELIEF THAT 

16 WE CAN GET EVERYTHING DONE, IF EVERYTHING WORKS PROPERLY, TO 

17 HAVE THE MARCH BALLOT, TO GET THE MARCH BALLOT DONE IN TIME? 

18

19 MARK PESTRELLA: SUPERVISOR, WE'VE DEVELOPED A TIMELINE THAT 

20 WOULD GIVE YOU THE OPTION TO PROVIDE FOR A MARCH BALLOT. IT 

21 WILL REQUIRE GREAT COORDINATION BETWEEN THE INTERNAL COUNTY 

22 FAMILY AS WELL AS OUR VENDORS TO DO THAT. WE HAVE A LIST OF 

23 COUNTY AGENCIES, COUNTY FAMILY MEMBERS THAT WE WOULD BE 

24 RELIANT TO MEET THE SCHEDULE. AND WE WOULD WELCOME A MOTION 
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1 FROM YOU TO DIRECT US TO WORK WITH THESE AGENCIES AND TO 

2 DEVELOP A TIMELINE. 

3

4 SUP. YAROSLAVSKY, CHAIRMAN: AND I INTEND TO DO THAT. BUT AS WE 

5 SIT HERE TODAY, IT IS POSSIBLE, IF EVERYTHING WORKS THE WAY 

6 IT'S SUPPOSED TO WORK, THAT YOU COULD GET THIS DONE IN TIME 

7 FOR THE MARCH BALLOT. 

8

9 MARK PESTRELLA: THAT'S CORRECT. 

10

11 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. ALL RIGHT. I'M GOING TO READ 

12 -- LET ME JUST READ THIS MOTION SO WE GET IT ON THE TABLE. 

13 "THE L.A. COUNTY FLOOD CONTROL DISTRICT IS CONSIDERING A 

14 BALLOT MEASURE TO LEVY A FEE ON PARCELS TO ADDRESS WATER 

15 QUALITY POLLUTION. STATE LAW REQUIRES THAT PUBLIC AS WELL AS 

16 PUBLIC AS WELL AS PRIVATELY OWNED PARCELS WITHIN THE LOS 

17 ANGELES COUNTY FLOOD CONTROL DISTRICT BE SUBJECT TO THIS FEE, 

18 INCLUDING GOVERNMENT AND SCHOOL DISTRICT PROPERTIES. SCHOOL 

19 DISTRICTS IN THE COUNTY OF LOS ANGELES ARE COMMITTED TO 

20 IMPROVING WATER QUALITY. HOWEVER SCHOOL DISTRICT BUDGETS HAVE 

21 BEEN STRAINED IN THE PAST FEW YEARS, SUCH THAT DISTRICTS WILL 

22 BE FISCALLY IMPACTED BY THE PROPOSED FEE. IN THE NEAR FUTURE 

23 SCHOOL DISTRICTS WILL BE CHALLENGED TO BUILD WATER QUALITY 

24 PROJECTS ON THEIR CAMPUSES. IN ADDITION, THERE IS A GREAT NEED 

25 TO PROVIDE STUDENTS AND TEACHERS WITH EDUCATION MATERIALS 
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1 CONCERNING WATER QUALITY AND OTHER ENVIRONMENTAL ISSUES. 

2 SCHOOLS PROVIDE AN EXCELLENT OPPORTUNITY FOR CITIES AND THE 

3 COUNTY TO INVEST IN WATER QUALITY EDUCATION. I THEREFORE MOVE 

4 THAT THE BOARD OF SUPERVISORS DIRECT THE DEPARTMENT OF PUBLIC 

5 WORKS AND COUNTY COUNSEL TO CONTINUE TO WORK WITH THE L.A. 

6 UNIFIED SCHOOL DISTRICT, THE LOS ANGELES COUNTY OFFICE OF 

7 EDUCATION, AND OTHER SCHOOL DISTRICTS TO INCLUDE IN THE FINAL 

8 DRAFT OF THE ORDINANCE AND/OR THE PROGRAM ELEMENTS PROVISIONS 

9 TO ADDRESS THE SCHOOL'S CONCERNS AND TO ENSURE THAT, ONE, 

10 SCHOOL DISTRICT REPRESENTATIVES ARE ENGAGED IN EACH OF THE 

11 NINE WATERSHED AUTHORITY GROUPS. TWO, A PORTION OF THE FUNDS 

12 ALLOCATED TO WATERSHED AUTHORITY GROUPS MAY BE USED TOWARDS 

13 IMPLEMENTATION OF PROJECTS AND PROGRAMS BY SCHOOL DISTRICTS, 

14 INCLUDING CAPITAL PROJECTS ON SCHOOL DISTRICT PROPERTIES AND 

15 EDUCATIONAL CURRICULA RELATED TO WATER QUALITY AND 

16 ENVIRONMENTAL AWARENESS." SECONDED BY RIDLEY-THOMAS. THAT 

17 WOULD BE AN AMENDMENT TO THE STAFF REPORT. I'D ALSO LIKE TO 

18 MOVE THAT "THE BOARD DIRECTS THE C.E.O., COUNTY ASSESSOR, THE 

19 COUNTY AUDITOR-CONTROLLER, THE COUNTY COUNSEL, REGISTRAR-

20 RECORDER AND THE EXECUTIVE OFFICE OF THE BOARD TO WORK WITH 

21 THE DEPARTMENT OF PUBLIC WORKS TO ENSURE A TIMELY DELIVERY OF 

22 A PROTEST HEARING AND TO REPORT BACK TO THE BOARD WITH THAT 

23 SCHEDULE. SECONDED BY RIDLEY-THOMAS. THAT'S APPROVED AS AN 

24 AMENDMENT AS PART OF THE STAFF REPORT. I JUST WANT TO SAY, 

25 THIS THING IS -- THIS INITIATIVE IS CRITICALLY IMPORTANT. AND 
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1 IT'S CRITICALLY IMPORTANT THAT WE DO IT ON OUR TERMS AND NOT 

2 HAVE IT IMPOSED ON US, FOR ONE THING. FIRST OF ALL, STORM 

3 WATER RUNOFF AND THE POLLUTION THAT IT CREATES, NOT ONLY IN 

4 THE OCEAN BUT THROUGHOUT OUR COMMUNITIES AS THEY COME THROUGH 

5 OUR REGION IS A PRESSING ISSUE FOR US. THE FEDERAL 

6 GOVERNMENT'S BREATHING DOWN OUR NECK. THE STATE GOVERNMENT'S 

7 BREATHING DOWN OUR NECK. AND THIS INITIATIVE, WHICH HAS BEEN 

8 YEARS IN THE MAKING, IS DESIGNED TO ADDRESS THE WATER 

9 POLLUTION ISSUES THAT FACE THIS COUNTY ON TERMS THAT WE CAN 

10 MANAGE, NOT ONLY WE THE COUNTY BUT THE 88 CITIES OF THE COUNTY 

11 AND THE SUBREGIONS OF THE COUNTY. AND THERE'S BEEN A LOT OF 

12 WORK DONE TO GET TO THIS POINT. IF WE DON'T DO THIS, AND WE 

13 COULD EASILY PUNT THIS TO ANOTHER BALLOT OR FUMBLE IT TO THE 

14 OPPOSITION, SO TO SPEAK, WE WILL HAVE THIS IMPOSED ON US BY A 

15 COURT, BY REGULATORY AGENCY OR BY BOTH. SO I THINK THIS IS THE 

16 WAY TO GO. IT'S AN UNTESTED APPROACH CERTAINLY FOR THIS 

17 COUNTY, BUT IT IS PROVIDED FOR IN THE LAW. IT IS FAIR. MORE 

18 PEOPLE WILL PARTICIPATE IN THIS THAN PARTICIPATED IN THE JUNE 

19 PRIMARY ELECTION OF A COUPLE OF WEEKS AGO. IT WILL GET -- 

20 BECAUSE IT WILL BE IN MARCH, IT WILL BE HIGHLY FOCUSED ON. 

21 THERE WILL BE VERY LITTLE COMPETITION FOR PUBLIC ATTENTION ON 

22 THESE KINDS OF MEASURES. IT IS CLEAR THAT THE PUBLIC WILL WANT 

23 SOMETHING DONE ABOUT DRINKING WATER TO MAKE SURE THAT OUR 

24 DRINKING WATER IS SAFE AND HEALTHY AND CLEAN AS WELL AS THE 

25 WATERS WE SWIM IN. SO I THINK -- I WANT TO CONGRATULATE THE 
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1 DEPARTMENT. I WANT TO CONGRATULATE AND THANK THE CHIEF 

2 EXECUTIVE OFFICE FOR PULLING TOGETHER WHAT WAS A VERY 

3 DISPARATE COALITION OF CITIES AND COGS AND SUBREGIONS AND WHAT 

4 HAVE YOU TO GET TO THE POINT WHERE EVERYBODY -- I SHOULDN'T 

5 SAY EVERYBODY -- MOST PEOPLE ARE ON BOARD TO THE EXTENT THAT 

6 THEY'RE NOT OPPOSING THIS. EVERYBODY IS AFRAID TO SUPPORT NEW 

7 REVENUES. BUT A LOT OF THEM ARE IN EVERY CITY IN THIS COUNTY 

8 AND MANY OF THE COGS, SUBREGIONS UNDERSTAND THAT THIS IS THE 

9 TICKET TO BRINGING THEMSELVES INTO COMPLIANCE OR SUBSTANTIAL 

10 COMPLIANCE WITH SOME OF THE REGULATORY ISSUES THAT FIND 

11 OURSELVES OUT OF COMPLIANCE AT THIS TIME. SO WITH THAT, I MOVE 

12 THE STAFF REPORT AS AMENDED BY THE TWO AMENDMENTS I INTRODUCED 

13 AND WE'LL HAVE DISCUSSION ON IT. MR. ANTONOVICH, YOU'RE NEXT. 

14

15 SUP. ANTONOVICH: WHAT IS THE COST TO L.A. COUNTY'S DEPARTMENT 

16 OF PARKS AND RECREATION TO COMPLY WITH THIS? 

17

18 MARK PESTRELLA: SUPERVISOR, WE DON'T HAVE IT BROKEN DOWN BY 

19 EACH DEPARTMENT. BUT THE COST TO THE INCORPORATED COUNTY, THE 

20 DEPARTMENTS CUMULATIVELY, IS AROUND $4 MILLION A YEAR. 

21

22 SUP. ANTONOVICH: SO AROUND $4 MILLION. IS THAT FOR THE PARKS 

23 AND RECREATION? 

24
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1 MARK PESTRELLA: NO. THE PARKS AND RECREATION WILL BE A SUBSET 

2 OF THAT $4 MILLION. 

3

4 SUP. ANTONOVICH: AND WHAT WOULD THAT $4 MILLION PERTAIN TO? 

5

6 MARK PESTRELLA: IT WOULD PERTAIN TO THE DEPARTMENTS' 

7 COMPLIANCE WITH THE CLEAN WATER ACT. 

8

9 SUP. ANTONOVICH: I KNOW. WHICH DEPARTMENTS ARE WE TALKING 

10 ABOUT? 

11

12 MARK PESTRELLA: ALL COUNTY DEPARTMENTS. 

13

14 SUP. ANTONOVICH: WHICH ONE SPECIFICALLY DEALING WITH THIS? 

15

16 MARK PESTRELLA: I'LL GIVE YOU EXAMPLES OF THE DEPARTMENTS. 

17 PARKS AND REC, I.S.D., SHERIFF, HEALTH, FIRE, LIBRARIES. 

18

19 SUP. ANTONOVICH: AND THESE ARE DOLLARS THAT WOULD BE COMING 

20 OUT OF THEIR GENERAL FUND? 

21

22 MARK PESTRELLA: YES. THERE ARE CURRENTLY DOLLARS COMING FROM 

23 GENERAL FUND TO PAY FOR THAT COMPLIANCE THAT WOULD BE 

24 REDIRECTED TO THIS PROGRAM. 

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: AND WE'RE ATTEMPTING TO DO A MAIL 

2 BALLOT IN AN OFF YEAR WHEN PEOPLE ARE ASLEEP INSTEAD OF 

3 PUTTING IT ON THE GENERAL ELECTION WHEN PEOPLE ARE AWARE OF 

4 BALLOT INITIATIVES, CORRECT? 

5

6 MARK PESTRELLA: WE ARE RECOMMENDING A MAIL-OUT BALLOT. 

7

8 SUP. ANTONOVICH: RIGHT. DOING IT IN AN OFF-YEAR ELECTION WHEN 

9 THERE ARE LESS PEOPLE VOTING AND HAVING A MAILMAN INSTEAD OF 

10 HAVING THE OPPORTUNITY TO GOING TO THE POLLING BOOTH AND 

11 VOTING. 

12

13 MARK PESTRELLA: THEY WOULD VOTE FROM HOME. 

14

15 SUP. ANTONOVICH: MORE OF A SNEAK ATTACK. CORRECT? 

16

17 MARK PESTRELLA: I WOULDN'T CALL IT A SNEAK ATTACK. WE WOULD BE 

18 NOTIFYING THEM UNDER THE PROVISIONS OF 218 THROUGH MAIL THAT 

19 SOMETHING'S COMING AND THEY WOULD HAVE THE -- 

20

21 SUP. ANTONOVICH: MORE PEOPLE ARE READING THE SAMPLE BALLOT 

22 THIS NOVEMBER WHEN WE TALK ABOUT PRESIDENTS, SENATORS, 

23 CONGRESSIONAL, ASSEMBLY, THAN THEY WILL IN MARCH WHEN THE 

24 PRESIDENT OR THE GOVERNOR ARE NOT ON THE BALLOT OR ANY U.S. 
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1 SENATE OR ANY STATE LEGISLATORS ON THE BALLOT, AND YET THIS IS 

2 A MULTIBILLION DOLLAR TAX THAT DOESN'T HAVE A SUNSET IN IT. 

3

4 GAIL FARBER: SUPERVISOR ANTONOVICH, I CAN'T PREDICT VOTER 

5 TURNOUT IN THE NEXT ELECTION. WE CAN SAY WITH THE 

6 RECOMMENDATION TO PROCEED WITH A MAIL OUT, IT'S A DIRECT 

7 EDUCATION AND OUTREACH EFFORT TO ALL PARCEL OWNERS, OVER 2 

8 MILLION, 2.1-PLUS MILLION PARCEL OWNERS, OF WHICH MAIL-OUT 

9 BALLOT TO THEM INFORMING THEM ABOUT THE PARCEL FEE AND THEN TO 

10 EXERCISE THEIR RIGHT TO RESPOND BY PARCEL BY HOUSEHOLD BACK TO 

11 THE DISTRICT ON THEIR PREFERENCE THERE. SO WE CAN SAY THAT WE 

12 WILL REACH ALL HOUSEHOLDS, ALL PARCELS WITHIN THE FLOOD 

13 CONTROL DISTRICT WITH THIS APPROACH. 

14

15 SUP. ANTONOVICH: WHICH A SAMPLE BALLOT RECEIVED FOR THE 

16 NOVEMBER ELECTION WHEN EVERYONE IS AWARE OF AN ELECTION WOULD 

17 BE ABLE TO INFORM MORE PEOPLE WITH THAT INFORMATION THAN WOULD 

18 BE INCLUDED IN A SAMPLE BALLOT WITH PRO AND CON ARGUMENTS, 

19 RIGHT? 

20

21 GAIL FARBER: AND AGAIN, SUPERVISOR, THAT DECISION WILL COME 

22 BACK TO THE BOARD IF YOU WOULD RATHER DO IT IN A GENERAL 

23 ELECTION VERSUS A MAIL OUT. 

24
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1 SUP. ANTONOVICH: WELL, WE COULD DO IT RIGHT NOW IN THE GENERAL 

2 ELECTION. PUT IT ON THE NOVEMBER ELECTION IF YOU WANTED TO. 

3 BECAUSE YOU HAVE UNTIL AUGUST TO MAKE THAT DECISION. 

4

5 GAIL FARBER: CORRECT. THAT'S THE BOARD'S DECISION. 

6

7 SUP. ANTONOVICH: SO YOU'D RECOMMEND THAT? OR YOU'D RATHER DO 

8 IT WHEN LESS PEOPLE ARE VOTING IN MARCH? 

9

10 GAIL FARBER: WE'LL, WE'D LIKE TO HAVE A SUCCESSFUL INITIATIVE. 

11

12 SUP. ANTONOVICH: NOT THE MOST INFORMED PEOPLE BUT WHERE MAYBE 

13 YOU CAN SNEAK SOMETHING THROUGH. BUT THIS IS A TAX THAT HAS A 

14 LIFE OF ITS OWN. IT DOESN'T HAVE A SUNSET. WE'VE HEARD ABOUT 

15 THE SCHOOL DISTRICT. THAT WAS JUST ONE SCHOOL DISTRICT. AND WE 

16 HAVE ABOUT 124 OR MORE SCHOOL DISTRICTS IN THE COUNTY OF LOS 

17 ANGELES THAT HAVE ADDITIONAL TAXES THAT WILL BE COMING OUT OF 

18 THEIR GENERAL FUND. AND THE STATE HAS NOT ALWAYS BEEN GENEROUS 

19 WITH THEIR GENERAL FUNDS FOR SCHOOLS. SCHOOLS HAVE NOT 

20 RECEIVED ALWAYS THE FULL FUNDING THAT THEY HAVE REQUESTED. 

21 ADDRESSING THE STORM WATER RUNOFF, WHAT PERCENTAGE OF PROBLEMS 

22 DO YOU SOLVE WITH THIS TAX? 

23
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1 MARK PESTRELLA: PERCENTAGE OF THE PROBLEM, WE INTENDED TO 

2 ADDRESS THE REGULATIONS AS SET FOR WATER BODIES THROUGH THE 

3 PROGRAM. SO WE'RE INTENDING TO ADDRESS ALL THE -- 

4

5 SUP. ANTONOVICH: SO THIS WOULD BE 100 PERCENT COMPLIANCE WITH 

6 THIS? 

7

8 MARK PESTRELLA: ULTIMATELY THE GOAL IS TO HAVE 100 PERCENT. 

9

10 SUP. ANTONOVICH: THE ULTIMATE GOAL. WHAT ARE WE LOOKING AT IN 

11 THE NEXT FIVE YEARS IF THIS WAS SUCCESSFULLY PASSED? WOULD WE 

12 BE ACHIEVING 100 PERCENT OF OUR GOAL? OR 1 PERCENT OF OUR 

13 GOAL? 

14

15 MARK PESTRELLA: I THINK THE GOAL FROM THE BEGINNING WOULD BE 

16 TO SLOW THE DEGRADATION IF NOT STOP THE DEGRADATION OF OUR 

17 WATER QUALITY IN THE COUNTY OF LOS ANGELES WITH AN ULTIMATE 

18 GOAL OF 100 PERCENT COMPLIANCE WITH THE BENEFICIAL USE -- 

19

20 SUP. ANTONOVICH: THAT'S ALWAYS THE GOAL. BUT WHAT DO YOU 

21 EXPECT TO ACHIEVE? I KNOW THE GOAL OF THE L.A. UNIFIED SCHOOL 

22 DISTRICT IN GRADUATING STUDENTS IS 100 PERCENT. BUT WHAT 

23 ACTUALLY, THE NUMBER THAT ACTUALLY GRADUATES IS WAY, WAY BELOW 

24 THAT. 

25
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1 MARK PESTRELLA: WELL, IF YOU TAKE A LOOK AT WHAT WE'VE DONE 

2 ALONG THE BEACHES IN L.A. COUNTY, IT'S BEEN FAIRLY SUCCESSFUL 

3 OVER ABOUT A 10-YEAR PERIOD IN REDUCING THE NUMBER OF CLOSED 

4 BEACHES, SUPERVISOR. AND THAT'S DIRECTLY PROPORTIONAL TO THE 

5 IMPROVEMENTS THAT THE L.A. COUNTY FLOOD CONTROL DISTRICT 

6 IMPLEMENTED ALONG THE SANTA MONICA BAY. AND I WOULD ASSUME, 

7 AND I BELIEVE THE SCIENCE SAYS THAT IF WE IMPLEMENT THE SAME 

8 LEVEL OF EFFORT IN OUR WATERWAYS OF SAN GABRIEL, L.A., THAT WE 

9 WILL SEE, LIKE I SAID, THE SLOWING OF THE DEGRADATION IF NOT 

10 STOPPING OVER TIME. 

11

12 SUP. ANTONOVICH: ARE YOU DOING THIS BECAUSE YOU HAD A POLL 

13 THAT GAVE YOU THE RESULTS YOU LIKED? 

14

15 MARK PESTRELLA: NO. WE WERE DIRECTED BY THE BOARD TO SEEK THE 

16 BEST AND MOST CLEAR METHOD FOR FUNDING A PROGRAM LIKE THIS IN 

17 2005. THERE WAS A DIRECTION BY THE BOARD TO DO THAT. AND THE 

18 RESULTS OF THAT WERE A RECOMMENDATION TO THE BOARD TO FUND IT 

19 THROUGH A PARCEL-RELATED FEE. AND WE'RE RECOMMENDING, AS THE 

20 DIRECTOR ALREADY STATED, A MAIL-OUT BALLOT AS THE MOST CLEAR 

21 METHOD FOR THE PROPERTY OWNER, NEXUS TO THE PERSON THAT IS 

22 ACTUALLY GOING TO RECEIVE THE FEE. 

23

24 GAIL FARBER: I'D LIKE TO ADD TO MARK'S COMMENTS AS FAR AS A 

25 GOAL OF 100 PERCENT COMPLIANCE AS WELL AS THE GOAL OF 
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1 IMPROVING OUR IMPAIRED WATER BODIES AND OUR BEACHES AND OUR 

2 WATERWAYS. I THINK IT ALSO ENSURES A COLLABORATIVE APPROACH, A 

3 REGIONAL COLLABORATIVE APPROACH AND A FRAMEWORK FOR ALL OUR 

4 WATERSHED PARTNERS AND MUNICIPALITIES TO COME TOGETHER AND 

5 WORK BY WATERSHED, PLANNING AND MANAGING THE WATER QUALITY AND 

6 DISCHARGES INTO OUR WATERWAYS SO THAT WE CAN MAKE A DIFFERENCE 

7 AND IMPROVE OUR IMPAIRED WATER BODY. SO IT DOES SET UP A 

8 STRUCTURED FRAMEWORK SO THAT THE STRUCTURE OF THE INITIATIVE 

9 AND THE PROGRAM IS TO DO JUST THAT, IS THAT WE'RE ALL WORKING 

10 TOGETHER AND PLANNING TOGETHER IN AN INTEGRATED FASHION TO 

11 BRING ABOUT THESE CRITICAL PROJECTS AND THE FUNDING TO FUND 

12 THESE CRITICAL PROJECTS IN A CROSS-JURISDICTIONAL AND REGIONAL 

13 WAY. 

14

15 SUP. ANTONOVICH: YOU'RE REACTING TO STATE AND FEDERAL 

16 REQUIREMENTS, THIS IS A STATE AND FEDERAL REQUIREMENT. AND THE 

17 STATE OR THE FEDERAL GOVERNMENT OUGHT TO BE PROVIDING THE 

18 GRANT RESOURCES TO RESOLVE THIS. BUT TO PUT IT ON THE BACK OF 

19 SCHOOL DISTRICTS, INDIVIDUAL HOMEOWNERS, IS A DISSERVICE. THE 

20 STANDARD IS NOT BEING ESTABLISHED BY THE COUNTY. WE'RE BEING 

21 DIRECTED BY FEDERAL AND STATE LAW OR COURT RULINGS. WE DON'T 

22 HAVE THE ABILITY TO CONTINUE TO GO TO OUR GENERAL FUND OR THE 

23 ABILITY TO CONTINUE TO TAX OUR POPULATION TO PAY FOR THESE. SO 

24 IF THE LEGISLATURE WANTS TO ENACT A LOT OF THESE PROGRAMS, 

25 THEY SHOULD COME UP WITH THE FUNDING INSTEAD OF GOING BACK TO 
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1 THE INDIVIDUAL PROPERTY OWNER. THE PROPERTY OWNERS HAVE THEIR 

2 BACK TO THE WALL. I WOULD RATHER HAVE PEOPLE BE ABLE TO KEEP 

3 THEIR HOME, KEEP THEIR APARTMENTS, TO PAY AFFORDABLE RENT, 

4 THAN TO HAVE THESE ADDITIONAL TAXES COME IN, SNUCK IN DURING 

5 AN OFF YEAR WITH A MAIL-IN BALLOT. I MEAN THIS WAS JUST 

6 DEFEATED IN CONTRA COSTA COUNTY. THERE'S NO RECORD OF SUCCESS. 

7 I WOULD RATHER PUT THIS EFFORT IN HAVING THE LEGISLATURE MAKE 

8 LAWS THAT WE CAN COMPLY WITH THAT ARE COST-EFFECTIVE INSTEAD 

9 OF DRIVING MORE PEOPLE OUT OF THIS COUNTY AND OUT OF THE 

10 STATE. WE ARE HAVING A TERRIBLE TIME TO CREATE JOBS. PEOPLE 

11 CAN GO TO ANOTHER COUNTY AND SAVE ABOUT 20 PERCENT OF THEIR 

12 COSTS. AND IT'S JUST AS EASY TO LOCATE IN VENTURA COUNTY, SAN 

13 BERNARDINO COUNTY, ORANGE COUNTY, RIVERSIDE COUNTY THAN IN LOS 

14 ANGELES COUNTY IF WE CONTINUE TO HAVE THESE ADDITIONAL COSTS. 

15 SO I THINK IT JUST IMPACTS TOO MANY PEOPLE FROM THE CLASSROOM 

16 TO THE HOSPITAL ROOM. SO I WOULD BE OPPOSED TO IT MR. 

17 CHAIRMAN. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. THANK YOU, MR. KNABE? 

20

21 SUP. KNABE: MIKE'S ADDRESSED A LOT OF THE ISSUES. BUT I THINK, 

22 YOU KNOW, ONE OF THE PIECES OF THIS PIE SUPPOSEDLY IS THIS 

23 WATER BOND THAT THE STATE'S PUTTING ON THE BALLOT TO SORT OF 

24 MATCH UP WITH WHAT WE'RE ATTEMPTING TO DO HERE FOR SOME WATER 

25 QUALITY. BREAKING NEWS THIS MORNING, THEY PUT THAT OFF UNTIL 
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1 2014, WHICH WOULD HAVE A DIRECT IMPACT ON WHAT WE'RE DOING 

2 HERE. THIS CLEARLY IS AN OPEN CHECKBOOK WITH NO SUNSET. AND IT 

3 CLEARLY IS A SNEAK ATTACK. YOU CAN DESCRIBE IT ANY OTHER WAY. 

4 I UNDERSTAND WHAT YOU WERE DIRECTED TO DO, BUT THE POLLINGS 

5 SHOW THAT IT FAILS AT THE BALLOT. I WAS JUST LECTURED A FEW 

6 DAYS AGO ON LETTING THE VOTERS DECIDE ON MEASURE "R" 

7 EXTENSION, HOW IMPORTANT IT WAS -- 

8

9 SUP. YAROSLAVSKY, CHAIRMAN: BUT YOU DIDN'T VOTE THAT WAY. 

10

11 SUP. KNABE: I DIDN'T VOTE FOR THAT; I'M NOT VOTING FOR THIS. 

12 THE POINT BEING IS THAT HAVING A BALLOT, A MAIL-IN BALLOT IN 

13 MARCH 2013 CLEARLY IS -- AND, GRANTED, I UNDERSTAND IT'S 

14 WITHIN THE FRAMEWORK OF THE LAW, BUT AS I READ LAST TIME TO 

15 ALL OF YOU ABOUT 17 DIFFERENT ITEMS ON MY OWN PERSONAL 

16 PROPERTY TAX BILL, ONCE AGAIN WITHOUT, YOU KNOW, HIDDEN IN A 

17 MARCH MAIL-IN BALLOT, THIS CLEARLY IS AN END RUN AROUND PROP 

18 218 BY NOT PUTTING IT ON THE BALLOT. AS FAR AS IT RELATES TO 

19 COUNTY DEPARTMENTS, I THINK MAYBE THE DEPARTMENT OF PUBLIC 

20 WORKS SHOULD PAY FOR ALL THE OTHER COUNTY DEPARTMENTS, SINCE 

21 IT'S SUCH A GREAT IDEA, DON'T YOU THINK? MAYBE WE CAN DEAL 

22 WITH THAT DOWN THE ROAD, AS WELL, SINCE YOU'RE SUCH A STRONG 

23 ADVOCATE FOR TAXING THE ELECTORATE TO PAY FOR SOMETHING THAT 

24 IS STATE AND FEDERAL RESPONSIBILITY. I'M NOT GOING TO REDO 

25 WHAT MIKE HAS SAID AND DONE, BUT I REALLY THINK THIS IS NOT 
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1 FAIR TO THE PEOPLE WE REPRESENT. WE'LL HAVE TO WORK JUST AS 

2 HARD ON THE OTHER SIDE TO EDUCATE THE PROPERTY OWNERS TO MAKE 

3 SURE THAT THEY UNDERSTAND EXACTLY WHAT'S HAPPENING AND EXACTLY 

4 WHAT THEY HAVE TO DO. TOTALLY OPPOSITE IF THEY GO TO A BALLOT 

5 BOX AND CHECK OFF SOMETHING. THIS TIME YOU SORT OF HAVE TO 

6 RESPOND TO SAY NO AND MAIL IT IN. AND IT COULD BE LIKE ANY 

7 OTHER PIECE OF JUNK MAIL THAT YOU GET. AND IT'S CLEARLY NOT 

8 GOING TO BE A FLASHING RED LIGHT SAYING: TRUST ME. READ THIS. 

9 LOOK AT IT. VOTE. IT WILL BE PROBABLY AS PLAIN JANE AS ANY 

10 PIECE OF PAPER CAN BE. SO I'M JUST DISAPPOINTED THAT WE DIDN'T 

11 PUT IT ON THE BALLOT. I DON'T HAVE A PROBLEM PUTTING THIS ON 

12 THE BALLOT BECAUSE I THINK THE VOTERS WOULD REALLY UNDERSTAND. 

13 AND IT'S TRULY, TRULY AN END RUN. SO WITH THAT, I ASK FOR A NO 

14 VOTE. 

15

16 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. THANK YOU. SUPERVISOR 

17 RIDLEY-THOMAS? MR. CHAIRMAN, COLLEAGUES, I THINK IT'S WORTH 

18 NOTING THAT THE DEPARTMENT HAS WORKED RATHER HARD ON WHAT HAS 

19 BEEN A CHALLENGING AND SOME WAYS VEXING PUBLIC POLICY ISSUE. 

20 IT'S NO DOUBT THAT THERE ARE SIGNIFICANT ENVIRONMENTAL AND 

21 PUBLIC HEALTH ISSUES AT STAKE HERE. AND TO THE EXTENT THAT 

22 THAT IS THE CASE, WE NEED TO DO ALL THAT WE CAN WHILE IT'S AT 

23 OUR INITIATION TO DO SO RATHER THAN BEING COMPELLED TO DO SO 

24 PURSUANT TO PERHAPS COURT ACTION OR SOMETHING OF THE SORT. 

25 NEED IT BE RESTATED THAT THE HEALTH AND PRODUCTIVITY 
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1 IMPLICATIONS HERE ARE SIGNIFICANT. WHEN WE THINK ABOUT THE 

2 POLLUTION ISSUES AND THE COSTS ASSOCIATED WITH THOSE ISSUES, 

3 WHEN WE THINK ABOUT THE CONTAMINATION ISSUES AND WE THINK 

4 ABOUT THE TOXINS AND THE LIKE OWING TO THE POLLUTANTS, THEY 

5 SIMPLY EXCEED REGULATORY AND HEALTH STANDARDS. AND TO THE 

6 EXTENT THAT THAT IS THE CASE, ARE WE NOT OBLIGED TO ACT? IT IS 

7 NOT AS IF WE HAVE DONE THIS HASTILY. THIS IS NOT A RUSH TO 

8 JUDGMENT. WE HAVE VETTED THIS, TURNED THIS THING SEVERAL 

9 DIFFERENT WAYS. AND IMPERFECT THOUGH IT MAY BE, IT IS, IN 

10 FACT, PROBABLY THE BEST THAT WE CAN DO AT THIS POINT IN TIME 

11 AND COMPLETELY DEFENSIBLE. LET'S SIMPLY SAY IT'S A PRUDENT 

12 COURSE OF ACTION. IS IT TO BE IGNORED THAT DOING SO HAS 

13 ECONOMIC DEVELOPMENT IMPLICATIONS? NOT SIMPLY THE ISSUE OF 

14 PUBLIC HEALTH, PUBLIC SAFETY, THE STANDARDS THAT ARE PUT IN 

15 PLACE IN TERMS OF ENVIRONMENTAL ISSUES, BUT WHAT ABOUT THE 

16 NUMBER OF JOBS THAT ARE CREATED TO THIS? WE SCORED IT SOME 

17 3600 JOBS. NOT A SMALL THING. ALL SORTS OF JOBS. FLOOD CONTROL 

18 DISTRICT WILL HAVE TO STAFF UP. THEN THERE'S THE PRIVATE 

19 SECTOR IMPLICATIONS THAT ATTACH TO IT IN TERMS OF THE 

20 CONTRACTING THAT GOES ON PURSUANT TO THE CLEANUP EFFORTS AND 

21 THE LIKE. NOT A SMALL THING. AND I SUSPECT THAT THE RESIDENTS 

22 OF LOS ANGELES COUNTY, THOSE THAT ARE DIRECTLY IMPACTED CARE 

23 ABOUT THIS ENOUGH TO CAUSE US TO DO WHAT IS NECESSARY TO 

24 IMPROVE THE QUALITY OF THEIR LIVES AND THE PUBLIC SECTOR 

25 ASPECTS OF IT, THE ENVIRONMENT GENERALLY SPEAKING. SO, MR. 
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1 CHAIRMAN, COLLEAGUES, I THINK WE SHOULD MOVE FORWARD. I'M 

2 PREPARED TO VOTE AFFIRMATIVELY BECAUSE THE TIME HAS COME FOR 

3 US TO SQUARE THIS BUSINESS AWAY. AND I THINK WE CAN DO IT IN 

4 GOOD FAITH. THANK YOU. 

5

6 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. SUPERVISOR MOLINA, DO 

7 YOU HAVE ANYTHING YOU WANT TO SAY? 

8

9 SUP. MOLINA: NO. OTHER THAN I THINK WE'VE ALLOWED A PROCESS 

10 HERE AT THE BOARD FOR AIRING OUT OF ALL OF THE DIFFERENT 

11 POINTS OF VIEW, BUT AT THE END OF THE DAY, WE HAVE A 

12 RESPONSIBILITY AND A DUTY AND HOPEFULLY WE CAN CONVINCE THE 

13 VOTERS TO JOIN US IN A PARTNERSHIP. BECAUSE BASICALLY THIS 

14 WHOLE THING IS THRUST UPON US AND WE'VE GOT TO MOVE 

15 EXPEDITIOUSLY TO MAKE SURE WE ARE DOING OUR PART ON CLEANING 

16 OUR WATER AND ALL THAT'S GOING INTO IT. SO I'M SUPPORTING THIS 

17 ASSESSMENT. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. THANK YOU. CALL THE ROLL. 

20

21 CLERK SACHI HAMAI: AND THIS IS FOR BOTH ITEM 26 AS WELL AS 

22 ITEM NO. 54? 

23

24 SUP. YAROSLAVSKY, CHAIRMAN: THAT'S RIGHT. 

25
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1 CLERK SACHI HAMAI: SO SUPERVISOR MOLINA? 

2

3 SUP. MOLINA: AYE. 

4

5 CLERK SACHI HAMAI: SUPERVISOR RIDLEY-THOMAS? 

6

7 SUP. RIDLEY-THOMAS: AYE. 

8

9 CLERK SACHI HAMAI: SUPERVISOR KNABE? 

10

11 SUP. KNABE: NO. 

12

13 CLERK SACHI HAMAI: SUPERVISOR ANTONOVICH. 

14

15 SUP. ANTONOVICH: NO. 

16

17 CLERK SACHI HAMAI: SUPERVISOR YAROSLAVSKY? 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: AYE. IT IS APPROVED. OKAY, THANK 

20 YOU. THAT'S ALL THE ITEMS I HAVE. SO SUPERVISOR KNABE, YOU'RE 

21 UP. WELL HE ALMOST BROUGHT TEARS TO HIS OWN EYES, BUT THAT'S 

22 ANOTHER STORY. BEFORE YOU START, MR. KNABE, I'M SORRY. 

23

24 SUP. KNABE: I THOUGHT IT WAS MY TURN. 

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: IT IS YOUR TURN. BUT SACHI HAS 

2 INFORMED ME AND I WANT TO MAKE SURE THE RECORD IS ABSOLUTELY 

3 CLEAR THAT -- IS DR. CLAVREUL STILL HERE? YOU KNOW WHAT? MY 

4 SUGGESTION IS AFTER I EXPLAIN THIS IN 10 SECONDS THAT MAYBE 

5 YOU MAKE A COPY OF THIS AND GIVE IT TO DOCTOR CLAVREUL SO SHE 

6 CAN -- OR YOU CAN GIVE HER THE ORIGINALS, GREAT. BECAUSE WE 

7 NOT ONLY HAVE THE JUNE 12 RECORD BUT ALSO THE JUNE 19 RECORD, 

8 INCLUDING THE CERTIFIED TRANSCRIPT OF THE DISCUSSION, AND NOT 

9 ONLY DID WE APPROVE IT UNANIMOUSLY, THE NOMINATION OF SANTOS 

10 KREIMANN TO BE CHIEF DEPUTY ASSESSOR, BUT WE HAD A NUMBER OF 

11 PEOPLE WHO SPOKE TO THE ITEM, INCLUDING MR. PREVEN, WHO 

12 APPARENTLY HAD FORGOTTEN THAT HE HAD SPOKEN ON THAT ITEM, AND 

13 MR. NAHHAS, WHO WAS HERE. SO THE RECORD IS VERY CLEAR. AND OF 

14 COURSE OURS WAS ONLY A NOMINATION. THE ACTUAL APPOINTMENT WAS 

15 MADE BY THE ASSESSOR HIMSELF. SO, ANYWAY, BUT THE POINT IS IT 

16 WAS DONE IN PUBLIC. THERE WAS NOT ONLY DONE IN PUBLIC, IT WAS 

17 A PUBLIC HEARING. AND THAT TAKES CARE OF THAT. ALL RIGHT. MR. 

18 KNABE? 

19

20 SUP. KNABE: MR. CHAIRMAN, I HAVE SEVERAL ADJOURNMENTS. FIRST 

21 OF ALL, THAT WE ADJOURN IN MEMORY OF MR. LEONARD IMADA, COUSIN 

22 OF DARLENE KUBA, WHO IS THE WIFE OF OUR C.E.O. BILL FUJIOKA, 

23 WHO PASSED AWAY AT THE AGE OF 65 ON JUNE 29. HE WAS A LONGTIME 

24 RESIDENT OF THE CITY OF NORWALK, WORKED IN THE POST OFFICE FOR 

25 OVER 33 YEARS. HE IS SURVIVED BY HIS WIFE, MUNCHAN; TWO SONS, 
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1 LAYNE AND DAVID; AND SIX GRANDCHILDREN. ALL MEMBERS. ALSO THAT 

2 WE ADJOURN IN MEMORY OF DR. JOEL NWAGBARA, WHO PASSED AWAY ON 

3 JUNE 12 AT THE AGE OF 76. LONGTIME RESIDENT OF CERRITOS, WAS A 

4 REGISTERED NURSE FOR MANY YEARS AT VARIOUS COUNTY FACILITIES. 

5 HE IS SURVIVED BY HIS WIFE, SELINAH, WHO HE MARRIED IN 1965; 

6 THEIR 10 CHILDREN; AND TWO GRANDCHILDREN. ALSO WE ADJOURN IN 

7 MEMORY OF MYRTLE PUGH, MOTHER OF RETIRED CHIEF ROY PUGH OF THE 

8 LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. PASSED AWAY AT THE 

9 AGE OF 93 ON JUNE 17. SHE IS SURVIVED BY HER TWO SONS, ROY AND 

10 TUDY; TWO DAUGHTERS, ELIZABETH AND GLORIA; BROTHER, ALCANO; 8 

11 GRANDCHILDREN; 14 GREAT GRANDCHILDREN; 4 GREAT GREAT 

12 GRANDCHILDREN; HOSTS OF NIECES, RELATIVES AND FRIENDS. ALSO 

13 THAT WE ADJOURN IN MEMORY OF RICK SEAREY, LONGTIME RESIDENT OF 

14 BELLFLOWER AND OWNER OF R.P.S. ROOFING, WHO PASSED AWAY 

15 RECENTLY AT THE YOUNG AGE OF 58. GRADUATE OF ST. JOHN BOSCO, 

16 HE RECENTLY WAS VOTED ROTARIAN OF THE YEAR AND WAS SET TO 

17 BECOME PRESIDENT OF THE BELLFLOWER ROTARY CLUB A COUPLE DAYS 

18 AGO, JULY 1. HE WAS ALSO VERY INVOLVED WITH OUR SISTER CITY 

19 PROGRAM. IT WAS A VERY SUDDEN PASSING. SURVIVED BY HIS WIFE, 

20 SUSAN; SONS, FRANCISCO AND MICHAEL; SISTERS, CINDY AND SUSAN. 

21 ALSO WE ADJOURN IN MEMORY OF ROBERT SERBELL, PASSED AWAY AT 

22 THE AGE OF 93, A PEARL HARBOR SURVIVOR. HE LANDED ON THE COAST 

23 OF FRANCE, REMAINED THERE DURING THE DURATION OF WORLD WAR II. 

24 HE HAD NUMEROUS POST-WAR OCCUPATIONS. AT THE AGE OF 60, HE 

25 WENT BACK TO SCHOOL, TRAINED TO BECOME AN L.V.N. AND WORKED AT 
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1 LITTLE COMPANY OF MARY IN TORRANCE FOR MANY YEARS. HE'S 

2 SURVIVED BY THREE DAUGHTERS, TWO SONS IN LAW, FOUR 

3 GRANDDAUGHTERS, ONE GRANDSON, TWO NEPHEWS AND ONE GRAND 

4 NEPHEW. ALSO THAT WE ADJOURN IN MEMORY OF GEORGE BUAIZ, WHO 

5 PASSED AWAY RECENTLY AT THE AGE OF 50. SURVIVED BY WIFE, JANN, 

6 AND SON, ANDREW. ALSO THAT WE ADJOURN IN MEMORY FINALLY WITH 

7 THELMA BELANGER OF LAKEWOOD. SHE'S SURVIVED BY HER SIX 

8 CHILDREN, JOHN, ANDREW, MARK, MATTHEW, MARY, AND MICHAEL; A 

9 SISTER, BROTHER, AND 10 GRANDCHILDREN, AND THREE GREAT 

10 GRANDCHILDREN. MR. CHAIRMAN, THOSE ARE MY ADJOURNMENTS. 

11

12 SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, UNANIMOUS VOTE. 

13

14 SUP. KNABE: I DON'T THINK I WAS HOLDING ANYTHING, WAS I? I 

15 RELEASED IT, I THOUGHT. 

16

17 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. SUPERVISOR ANTONOVICH? 

18

19 SUP. ANTONOVICH: I'D LIKE TO ADJOURN TODAY IN MEMORY OF 

20 MARILYN VIDOVICH, WHO PASSED AWAY ON JUNE 17. SHE WAS THE 

21 GRANDMOTHER OF MY FORMER INTERN, KATHRYN. SURVIVED BY HER 

22 CHILDREN AND HER GRANDCHILDREN AND SISTER. SHE WAS A COMMUNITY 

23 LEADER AND QUITE ACTIVE IN THE CROATIAN COMMUNITY. SUPERVISOR 

24 YAROSLAVSKY MENTIONED ADJOURNMENT FOR ANDY GRIFFITH. I WOULD 

25 ALSO LIKE TO JOIN IN THAT. WHEN I WAS IN THE LEGISLATURE, ONE 
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1 OF THE LAWS I ENACTED WAS CREATING THE HERITAGE OLD TIME 

2 LICENSE PLATE FOR HERITAGE VEHICLES AND OLD VEHICLES. AND 

3 ANDY, WE HAD THE DRAWING FOR THE LICENSE PLATE NUMBER, IT WAS 

4 AT THE GLENDALE DEPARTMENT OF MOTOR VEHICLES. AND I HAD ANDY 

5 GRIFFITH DO THE DRAWING FOR THE FIRST LICENSE PLATE THAT WAS 

6 TO BE ISSUED, BECAUSE ANDY WAS ALSO A GREAT COLLECTOR OF OLD 

7 VEHICLES. AS IT WAS STATED, HE WAS A REALLY WONDERFUL ROLE 

8 MODEL AND GOOD HUMANITARIAN AND SUPERB ACTOR. ALSO I'D LIKE TO 

9 MOVE THAT WE ADJOURN IN MEMORY OF NORMAN RIPS. HE WAS QUITE 

10 ACTIVE IN OUR COMMUNITY. HE PASSED AWAY ON JUNE 28. GEORGE 

11 RANDOLPH HEARST, WHO WAS FORMER BOARD CHAIRMAN OF THE HEARST 

12 CORPORATION AND OF THE SAN FRANCISCO EXAMINER AND THE LOS 

13 ANGELES EXAMINER AND THE LOS ANGELES EVENING HERALD EXPRESS, 

14 WHO PASSED AWAY LAST MONTH. JOHN GILWEIT, RETIRED DEPUTY 

15 SHERIFF, WHO PASSED AWAY AT THE AGE OF 70. PEARL TARBUSH, WHO 

16 DIED JUST THIS WEEK. SHE WAS A FEW DAYS SHORT OF HER 96TH 

17 BIRTHDAY. IN THE EARLY YEARS SHE WORKED AS AN ACTRESS IN THE 

18 SILENT MOVIES AND DURING WORLD WAR II SHE ASSEMBLED AIRCRAFT 

19 FOR MCDONNELL-DOUGLAS AND LATER SERVED AS AN AMBASSADOR AT THE 

20 LOS ANGELES CITY HALL AND WAS PRESIDENT IN THE SANTA SUSANA 

21 MOUNTAIN PARKS ASSOCIATION, WHERE SHE HELPED OBTAIN ACREAGE 

22 FOR THE SANTA SUSANA PASS STATE HISTORIC PARK. SHE WAS QUITE 

23 ACTIVE IN THE REPUBLIC WOMEN'S FEDERATED CLUB. SURVIVED BY HER 

24 HUSBAND, CHUCK, AND HER THREE CHILDREN. ALSO ADJOURN IN MEMORY 

25 OF ELLEN HINDERER WIRTH, PASSED AWAY AT THE AGE OF 58. 
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1 LONGTIME RESIDENT OF LOS ANGELES COUNTY AND SHE LEAVES HER 

2 SON, HUGO. TYLER MINCH, PRESIDENT OF SANTA CLARITA VALLEY, 

3 PASSED AWAY IN CHINA WHERE HE HAD GONE TO ATTEND A FAMILY 

4 WEDDING WITH HIS GRANDMOTHER. HE WAS ONLY SEVEN YEARS OLD, HE 

5 PASSED AWAY. CHAD BECKEN, LIFETIME RESIDENT OF LOS ANGELES 

6 COUNTY, FROM BURBANK. DONNA MAE BOLTON, RESIDENT OF LANCASTER 

7 FOR THE PAST 54 YEARS, ACTIVE IN THE COMMUNITY. SHE LEAVES HER 

8 CHILDREN. BABA DRAGA PASSED AWAY ON JUNE 30 AT THE AGE OF 97, 

9 LONGTIME MEMBER OF THE ST. ANTHONY'S CROATIAN CATHOLIC CHURCH. 

10 JOSEPH ANTHONY VALLECORSA, JR., RESIDENT OF SAN DIMAS, PASSED 

11 AWAY AT THE AGE OF 68. SERVED IN THE UNITED STATES ARMY WORKED 

12 FOR THE SOUTHERN CALIFORNIA EDISON COMPANY FOR THE PAST 40 

13 YEARS AND WAS A MEMBER OF THE SAN DIMAS CITY'S PLANNING 

14 COMMISSION. DEBBIE WILSON, SHE WORKED FOR 20 YEARS AT 

15 DISNEYLAND'S MAKEUP DEPARTMENT AND HAIR STYLIST. SURVIVED BY 

16 HER HUSBAND. DR. GARLAND MOORE, VETERINARIAN IN THE UNITED 

17 STATES ARMY. AND ALSO IN THE PAST HAD BEEN PRESIDENT OF NORTH 

18 HOLLYWOOD YOUNG REPUBLICANS. HE IS SURVIVED BY HIS WIFE, 

19 DARLENE. RUTH SHELTON STONE, SHE OPERATED THE LOCKWOOD ESCROW 

20 CORPORATION, COFOUNDER OF THE BROOKSIDE SAVINGS AND LOAN 

21 ASSOCIATION, WHERE SHE SERVED ON THE BOARD OF DIRECTORS OF THE 

22 SALVATION ARMY, MEMBER OF THE ESCROW INSTITUTE OF CALIFORNIA 

23 AND ACTIVE IN THE SAN GABRIEL VALLEY. EDWARD JOSEPH RIVAS, 

24 ANOTHER WORLD WAR II VETERAN FROM LANCASTER. MELVIN "JOHN" 

25 REBEL, RETIRED DEPUTY SHERIFF OF LOS ANGELES COUNTY, LAST 
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1 ASSIGNMENT WAS AT OUR TEMPLE STATION. THOSE ARE MY 

2 ADJOURNMENTS. 

3

4 SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, UNANIMOUS VOTE. 

5

6 SUP. ANTONOVICH: I HAVE A MOTION I WANT TO INTRODUCE. ITEM 10, 

7 "L.A. COUNTY HAS A POPULATION OF APPROXIMATELY 10 MILLION 

8 RESIDENTS WITH A VERY DIVERSE ECONOMIC BASE THROUGHOUT THE 

9 REGION. BUSINESS ASSISTANCE EFFORTS PROVIDED BY THE COUNTY DO 

10 ATTRACT AND RETAIN AND GROW BUSINESSES AND JOBS AND TARGET 

11 AREAS OF SPECIAL ATTENTION THAT PARTICULARLY BENEFIT 

12 UNINCORPORATED AREA RESIDENTS. INVESTMENT FOR THE PURPOSE OF 

13 FUNDING PROGRAMS TO CREATE OR MAINTAIN JOBS, STIMULATE 

14 BUSINESS GROWTH, UPGRADE THE BUSINESS CLIMATE AND IMPROVE 

15 COMMERICAL SERVICE PRIMARILY IN DISTRESSED OR UNDEVELOPED 

16 AREAS OF OUR COUNTY IS MUCH NEEDED. THESE FUNDS WOULD BE USED 

17 FOR DIRECT BUSINESS ASSISTANCE TO ATTRACT, RETAIN, REVITALIZE, 

18 AND EXPAND BUSINESSES. THEREFORE I MOVE THAT THE BOARD DIRECT 

19 THE C.E.O. TO EQUALLY DIVIDE THE $1.25 MILLION THAT ARE 

20 ALREADY INCLUDED IN THE FISCAL YEAR 2012-13, RECOMMENDED 

21 BUDGET BY DISTRICT IN ORDER TO IMPLEMENT A LOCAL BUSINESS 

22 ASSISTANCE ECONOMIC DEVELOPMENT AND JOB DEVELOPMENT SOLUTION 

23 IN TARGETED COMMUNITIES TO ALLOW FUNDS TO BE ALLOCATED TO THE 

24 L.A. COUNTY ECONOMIC DEVELOPMENT CORPORATION, THE COMMUNITY 

25 DEVELOPMENT COMMISSION OR ANY OTHER ENTITY THAT CAN ADVANCE 
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1 THE GOALS OF TIMELY AND RELEVANT ECONOMIC INFORMATION AND 

2 ANALYSIS, DIRECTING BUSINESS ASSISTANCE TO ATTRACT, RETAIN AND 

3 EXPAND BUSINESSES, NETWORKING AND ASSISTING TECHNOLOGY-BASED 

4 BUSINESSES TO HELP CREATE NEW INDUSTRIES, AND FOCUS ECONOMIC 

5 DEVELOPMENT STRATEGIES SUPPORTED BY TIMELY RESULTS OF ORIENTED 

6 INITIATIVES FOR THE LOS ANGELES COUNTY REGION." ALLEN, YOU 

7 HAVE A MOTION? 

8

9 SUP. YAROSLAVSKY, CHAIRMAN: THIS IS -- 

10

11 SUP. ANTONOVICH:  ITEM 10. 

12

13 SUP. YAROSLAVSKY, CHAIRMAN: IS THERE A SECOND TO THAT MOTION? 

14 IS THERE ANY DISCUSSION? 

15

16 SUP. KNABE: I'D LIKE TO CONTINUE THE ITEM A WEEK. I NEED TO 

17 LOOK AT THIS. 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: DO YOU HAVE A PROBLEM WITH THAT? 

20

21 SUP. ANTONOVICH: YES. 

22

23 SUP. YAROSLAVSKY, CHAIRMAN: ONE WEEK? 

24

25 SUP. ANTONOVICH: YES. 
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1

2 SUP. YAROSLAVSKY, CHAIRMAN: YOU HAVE A PROBLEM CONTINUING IT 

3 ONE WEEK? 

4

5 SUP. ANTONOVICH: YES. I THINK WE SHOULD VOTE ON IT TODAY. 

6

7 SUP. YAROSLAVSKY, CHAIRMAN: WHY DO YOU HAVE A PROBLEM WITH A 

8 WEEK? 

9

10 SUP. ANTONOVICH: BECAUSE I BELIEVE THAT THERE ARE WAYS OF 

11 MOVING FORWARD TO CREATE JOBS. WE HAVE SERIOUS PROBLEMS 

12 ECONOMICALLY. AND THIS IS A WAY OF ENSURING THAT WE CAN CREATE 

13 GREATER ECONOMIC DEVELOPMENT IN OUR REGIONS. 

14

15 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. CALL THE ROLL. 

16

17 CLERK SACHI HAMAI: SO THIS IS ON SUPERVISOR -- 

18

19 SUP. YAROSLAVSKY, CHAIRMAN: LET ME JUST ASK. DO YOU WANT TO 

20 MAKE A MOTION TO CONTINUE IT A WEEK. 

21

22 SUP. KNABE: I MAKE A MOTION TO CONTINUE IT A WEEK WITH HIS 

23 AMENDMENT. 

24

25 CLERK SACHI HAMAI: AM I CALLING THE ROLL ON THAT? 
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1

2 SUP. YAROSLAVSKY, CHAIRMAN: YES. CALL THE ROLL ON -- MR. KNABE 

3 WOULD LIKE TO CONTINUE THE WHOLE ITEM. 

4

5 SUP. KNABE: TO ANALYZE MIKE'S AMENDMENT. I MAY BE WITH HIM ON 

6 IT. BUT HE DIDN'T SHARE IT WITH THE OFFICE. 

7

8 CLERK SACHI HAMAI: OKAY. SO WE'RE CALLING THE ROLL ON THE 

9 CONTINUANCE. SUPERVISOR MOLINA? 

10

11 SUP. MOLINA: NO. 

12

13 CLERK SACHI HAMAI: SUPERVISOR RIDLEY-THOMAS? 

14

15 SUP. RIDLEY-THOMAS: NO. SUPERVISOR KNABE? 

16

17 SUP. KNABE: AYE. 

18

19 CLERK SACHI HAMAI: SUPERVISOR ANTONOVICH? 

20

21 SUP. ANTONOVICH: AYE-- NO, NO. [LAUGHTER.] 

22

23 CLERK SACHI HAMAI: IT WILL BE RECORDED AS A NO. SUPERVISOR 

24 YAROSLAVSKY? 

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: NO. I MEAN YES ON THE CONTINUANCE. 

2 [LAUGHTER.] 

3

4 SUP. RIDLEY-THOMAS: WAIT A MINUTE, ZEV. WHAT'S IT GOING TO BE? 

5

6 SUP. YAROSLAVSKY, CHAIRMAN: SO THAT IS DEFEATED 3-2. SO NOW 

7 YOU HAVE THE MOTION, MR. ANTONOVICH'S AMENDMENT IS BEFORE US. 

8

9 CLERK SACHI HAMAI: CORRECT. SO SUPERVISOR MOLINA? 

10

11 SUP. MOLINA: AYE. 

12

13 CLERK SACHI HAMAI: SUPERVISOR RIDLEY-THOMAS? 

14

15 SUP. RIDLEY-THOMAS: AYE. 

16

17 CLERK SACHI HAMAI: SUPERVISOR KNABE? 

18

19 SUP. KNABE: NO. 

20

21 CLERK SACHI HAMAI: SUP. ANTONOVICH? 

22

23 SUP. ANTONOVICH: AYE. 

24

25 CLERK SACHI HAMAI: SUPERVISOR YAROSLAVSKY? 
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1

2 SUP. YAROSLAVSKY, CHAIRMAN:  AYE. 

3

4 CLERK SACHI HAMAI: MOTION CARRIES. 

5

6 SUP. ANTONOVICH: THE OTHER MOTION I HAVE ON 55-C. 

7

8 CLERK SACHI HAMAI: A. 

9

10 SUP. ANTONOVICH: ON THIS MOTION, MR. CHAIRMAN, I WOULD LIKE TO 

11 AMEND IT SO THAT IN PART 2 AND 3 OF YOUR MOTION, WHERE YOU SAY 

12 'DOCUMENT THE STEPS THEY ARE TAKING TO PREPARE FOR THE 

13 PROJECTED EFFECTS OF CLIMATE CHANGE AND RECOMMEND ANY 

14 ADDITIONAL ACTIONS THAT THE COUNTY SHOULD TAKE TO HELP THE 

15 REGION PREPARE FOR THE EFFECTS OF THESE CLIMATE CHANGE.' I 

16 WOULD LIKE TO HAVE A COST ANALYSIS OF RECOMMENDATIONS THAT 

17 WOULD BE ADOPTED, BECAUSE I DON'T KNOW WHAT WE WOULD BE 

18 COMMITTING THE COUNTY TO DO WITHOUT A COST ANALYSIS." 55-A. 

19 WITHOUT A COST ANALYSIS, ON IMPACT ON OUR COUNTY DEPARTMENTS, 

20 WE ARE MANDATING PROGRAM THAT THIS BOARD MAY BE OPPOSING, I 

21 DON'T KNOW. WHAT I WAS SAYING ON PART 2 AND 3 OF YOUR PROPOSAL 

22 WHERE YOU'RE RECOMMENDING THAT WE WOULD TAKE THESE ACTIONS, 

23 THAT WE WOULD FIRST HAVE A COST ANALYSIS OF ANY 

24 RECOMMENDATIONS SO THAT THE BOARD WOULD KNOW WHAT IS BEING 
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1 RECOMMENDED AND THE COSTS AND JOB ANALYSIS WHICH WOULD PREPARE 

2 US TO MAKE A DECISION ON THOSE AT THAT TIME. 

3

4 CLERK SACHI HAMAI: THAT ITEM IS BEFORE YOU. THEN WE WILL AMEND 

5 IT TO ADD THE COST ANALYSIS FOR ITEMS 2 AND 3? 

6

7 SUP. YAROSLAVSKY, CHAIRMAN: YEAH. 

8

9 SUP. ANTONOVICH: REPORT BACK. 

10

11 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. SO I'LL MOVE IT. SECOND 

12 BY KNABE. WITHOUT OBJECTION, UNANIMOUS VOTE AS AMENDED. 

13

14 SUP. ANTONOVICH: THANK YOU. THAT'S ALL I HAD. 

15

16 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. SUPERVISOR MOLINA? 

17 YOU'RE NOT HOLDING ANYTHING? SUPERVISOR RIDLEY-THOMAS? 

18

19 SUP. RIDLEY-THOMAS: JUST BRIEFLY, MR. CHAIR, COLLEAGUES, ITEM 

20 NO. 4, AMENDING THAT EFFORT INTRODUCED BY SUPERVISOR 

21 YAROSLAVSKY, AND THE READ-IN IS AS FOLLOWS. "DIRECT I.S.D. AND 

22 THE C.I.O. TO CARRY OUT A THOROUGH NETWORK AND BANDWIDTH 

23 UTILIZATION ASSESSMENT FOR EACH COUNTY LOCATION PRIOR TO ANY 

24 VIDEO-CONFERENCE EQUIPMENT IMPLEMENTATION TO ENSURE USABILITY 

25 AND RELIABILITY OF THE SERVICE. DIRECT THE I.S.D. AND C.I.O. 
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1 TO FOLLOW THE I.T.U., THAT IS THE INTERNATIONAL 

2 TELECOMMUNICATION UNION STANDARDS FOR VIDEO-CONFERENCING 

3 PROTOCOLS AND AUDIO-VIDEO COMPRESSION TO MAINTAIN 

4 COMPATIBILITY ACROSS COUNTY AND WORLDWIDE SYSTEMS. DIRECT THE 

5 I.S.D. AND C.I.O. TO PROVIDE ADEQUATE TRAINING FOR COUNTY 

6 EMPLOYEES AND CREATE USER-FRIENDLY TRAINING MATERIALS 

7 AVAILABLE ONLINE AND OFFLINE. AND THEN FINALLY, MANDATE THE 

8 USE OF VIDEO CONFERENCE EQUIPMENT WHEN POSSIBLE AS AN 

9 ALTERNATIVE FOR PARTICIPANTS TO PHYSICALLY ATTEND MEETINGS." I 

10 WANT TO INDICATE THAT APPROVAL OF THIS MOTION THAT WILL 

11 REQUIRE STANDARDS FOR COMPATIBILITY AND AVAILABILITY OF VIDEO- 

12 CONFERENCING SYSTEMS IS VERY IMPORTANT. I COMPLIMENT THE MAKER 

13 OF THE MOTION FOR IT. IF WE'RE GOING TO CAUSE OUR CAPACITY 

14 TECHNOLOGICALLY AND OUR COMMUNICATION WITH OUR RESPECTIVE 

15 PUBLICS TO BE REAL IF WE'RE GOING TO MAXIMIZE OUR 

16 EFFICIENCIES, IT SEEMS TO ME THAT A MOTION OF THIS SORT IS 

17 NECESSARY AND THE AMENDMENTS ONLY SUPPORT IT IN THAT MANNER. 

18 THE WORST THING WE CAN DO IS ACQUIRE THIS EQUIPMENT AND NOT 

19 CAUSE IT TO BE COMPATIBLE AND, SECONDLY AND MORE 

20 FUNDAMENTALLY, USED. THEREFORE ALL THAT CAN BE DONE SHOULD BE 

21 DONE TO MAKE SURE WE ARE WISELY AND APPROPRIATELY UTILIZING 

22 THE EQUIPMENT AND TAKING FULL ADVANTAGE OF IT. THAT WOULD BE 

23 MY AMENDMENT TO THE MOTION. 

24
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1 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. I ACCEPT THAT AS A 

2 FRIENDLY AMENDMENT. WITHOUT OBJECTION. WE HAVE THE ITEM BEFORE 

3 US? I'LL MOVE IT. SECONDED BY RIDLEY-THOMAS WITHOUT OBJECTION, 

4 UNANIMOUS VOTE. 

5

6 SUP. RIDLEY-THOMAS: THANK YOU, MR. CHAIRMAN. 

7

8 SUP. YAROSLAVSKY, CHAIRMAN: NEXT ITEM? ARE YOU HOLDING 

9 ANYTHING ELSE? 

10

11 SUP. RIDLEY-THOMAS: NO. 

12

13 SUP. YAROSLAVSKY, CHAIRMAN: NO ADJOURNING MOTIONS? ALL RIGHT. 

14 S-1 IS NOW BEFORE US. ALL RIGHT. DR. CLAVREUL? AND E.T. SNELL? 

15 AND ERIC PREVEN. 

16

17 DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS, 

18 DR. GENEVIEVE CLAVREUL. ON THE REPORT, IT WILL BE NICE IF ONCE 

19 AND A WHILE DR. KATZ WOULD BE HERE TO PRESENT REPORT, BUT THAT 

20 WOULD BE ASKING WAY TOO MUCH, I'M SURE. WHEN WE LOOKED AT THIS 

21 REPORT, FIRST OF ALL, THERE IS A TREMENDOUS INCREASE IN 

22 DENSELY OVERCROWDED WHICH WENT FROM 1.1 PERCENT WHICH IS 6.2 

23 PERCENT WHICH IS FANTASTIC INCREASE. AND ALSO OUR LENGTH OF 

24 STAY AGAIN HAVE INCREASED FROM 5.9 TO 6.3. WHEN YOU LOOK AT 

25 ALL THE REPORTS ON U.S.C., WHAT WE HAVE CONSTANTLY IS UPS AND 



July 3, 2012

68

1 DOWN, UPS AND DOWN. I MEAN LIKE I SAID BEFORE, IT LOOKS LIKE A 

2 DRUNKEN SAILOR IS AT THE HEAD OF THE HOSPITAL, BUT THAT WOULD 

3 BE AN INSULT TO THE SAILORS. IT'S DEFINITELY SOMETHING WHICH 

4 IS NOT KOSHER BECAUSE IT SHOULD NOT BE GOING THIS WAY. EITHER 

5 WE IMPROVE OR WE DON'T. BUT WE DON'T CONSTANTLY GO UP AND 

6 DOWN. AND IF YOU LOOK AT THE RESULT, IT IS A CONSTANT UP AND 

7 DOWN FOR THE LAST -- SINCE U.S.C. HAS BEEN OPENED. SO I 

8 DEFINITELY WILL HIGHLY RECOMMEND AN IN-DEPTH REVIEW OF WHAT'S 

9 REALLY GOING ON BECAUSE THOSE SITUATIONS ARE NOT GOOD, NEITHER 

10 FOR THE PATIENT NOR FOR THE NURSES OR THE PHYSICIANS. AND 

11 ESPECIALLY THE LENGTH OF STAY DEFINITELY INCREASED OUR COST. 

12 DENSELY OVERCROWDING PUTS EVERYBODY IN JEOPARDY. AND I KNOW I 

13 DON'T WANT TO BE A PATIENT WHEN IT IS OVERCROWDED TO 60.2 

14 PERCENT BECAUSE I KNOW I WOULD NOT BE -- IT IS NOT HUMANLY 

15 POSSIBLE TO PROVIDE TOP CARE UNDER THAT AMOUNT OF STRESS. AND 

16 THAT'S ALL I WOULD HAVE TO SAY TODAY. 

17

18 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU VERY MUCH. MR. SNELL? 

19

20 E.T. SNELL: WOULD YOU ALLOW MR. PREVEN TO GO UP? 

21

22 ERIC PREVEN: I'D BE HAPPY TO. 

23

24 SUP. YAROSLAVSKY, CHAIRMAN: NO. YOU'RE UP MR. SNELL. 

25
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1 E.T. SNELL: YOU WON'T LET ME FIND MY NOTES. THERE YOU GO 

2 AGAIN. YOU WONDER WHY I DRESS LIKE THIS. 

3

4 SUP. YAROSLAVSKY, CHAIRMAN: YES, I DO. ACTUALLY I DON'T. 

5 FORMALWEAR FOR SOME PEOPLE. MR. PREVEN, YOU'RE UP. 

6

7 ERIC PREVEN: YES, MY NAME IS ERIC PREVEN, I AM THE COUNTY 

8 RESIDENT FROM DISTRICT 3. AND GENEVIEVE HAS IDENTIFIED THE 

9 SAME AREAS THAT I DID, WHICH HAS TO DO WITH THE DANGEROUSLY 

10 OVERCROWDING AT 6.2 PERCENT, WHICH IS EXTREMELY HIGH. AND IT 

11 WAS 1.1 PERCENT JUST IN APRIL. SO THESE NUMBERS ARE INCREDIBLY 

12 SPORADIC, WHICH OF COURSE COULD BE ATTRIBUTED TO LIFE AND WHAT 

13 IT BRINGS, THERE ARE VARIOUS EVENTS THAT DO OCCUR. BUT THERE 

14 WERE NO EXTRAORDINARY EVENTS THAT WE CAN IDENTIFY THAT WOULD 

15 HAVE CAUSED THIS SPIKE. SO I WONDER IF OUR REPORTING IS 

16 ACCURATE, IS A GOOD QUESTION. I MEAN I DON'T KNOW THE ANSWER 

17 TO THAT. I DO KNOW THAT WHEN YOU READ THIS REPORT CAREFULLY, 

18 AS I HAVE, A COUPLE OF THE ITEMS, ESPECIALLY THE LENGTH OF 

19 TIME THAT ONE WAITS IN AN EMERGENCY DEPARTMENT IS EXTREMELY 

20 HIGH. IT'S 8 POINT SOMETHING HOURS, TYPICALLY. SOMETIMES 9, 

21 SOMETIMES AS HIGH AS 11. NOW, I KNOW AS GOVERNMENTAL LEADERS 

22 AND THE PEOPLE WHO ARE ULTIMATELY RESPONSIBLE FOR THIS, THAT'S 

23 NOT YOUR DESIRE TO HAVE PEOPLE WHO ARE IN DIRE STRAITS WAITING 

24 AROUND FOR SUCH A LONG PERIOD OF TIME. AND I ALSO KNOW THAT WE 

25 HAVE A NATIONAL CRISIS WITH THE SHORTAGE OF DOCTORS AND 
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1 NURSES. SO WE ARE GRAPPLING WITH SOME DIFFICULT PROBLEMS. THAT 

2 SAID, SOLVING THESE KINDS OF PROBLEMS WILL BE MORE LIKELY, AND 

3 WE WILL HOLD OUR VARIOUS DEPARTMENTS, INCLUDING DR. KATZ, WHO 

4 I KNOW MANY OF YOU FEEL IS DOING AN EXCELLENT JOB, AND I CAN'T 

5 REALLY DISPUTE THAT AT THE MOMENT, BUT IF WE WERE TO IMPLEMENT 

6 SOMETHING OTHER THAN NO TARGET VALUE FOR THE WAIT TIME AND 

7 ACTUALLY STRIVE TO ACHIEVE SOMETHING LIKE, SAY, SIX HOURS OR 

8 FIVE HOURS OR A GOAL, JUST LIKE YOU WOULD TELL A JUNIOR HIGH 

9 SCHOOL STUDENT IF YOU WANT TO IMPROVE YOUR GRADES OR IF YOU 

10 WANT TO IMPROVE YOUR COMPLIANCE WITH A TASK, SET A REASONABLE 

11 GOAL. I FIND NO TARGET VALUE, LOWER NUMBERS ARE BETTER, A VERY 

12 TRUE STATEMENT, BUT I THINK WE CAN DO BETTER THERE. AND THE 

13 OTHER CONCERN REGARDING THIS IS OF COURSE LAST WEEK OR A 

14 COUPLE WEEKS AGO, WE SAW 37 OR SO ITEMS FLUSH THROUGH THIS 

15 BOARD AT AN ALARMING RATE REPRESENTING MILLIONS AND MILLIONS 

16 OF DOLLARS FOR VARIOUS I.T. ACCESSORIES TO OUR HEALTHCARE 

17 SYSTEM. I AM VERY WORRIED THAT A LOT OF THIS MONEY THAT'S 

18 BEING DEPLOYED WITH -- I MEAN I CAN THROW A FEW NAMES OUT, BUT 

19 IT'S REALLY NOT THE POINT -- IS BEING DEPLOYED FOR EXECUTIVES 

20 OUT OF STATE AS OPPOSED TO FOR DOCTORS AND NURSES IN OUR 

21 COMMUNITIES TO TREAT THE PEOPLE WHO ARE IN NEED AND WHO ARE 

22 WAITING AROUND FOR UP TO EIGHT HOURS. NOW, I DON'T WANT TO 

23 MAKE LIGHT OF THESE THINGS. AND I KNOW THAT GETTING MORE 

24 DOCTORS APPARENTLY IN A FEW YEARS, MEDITATE ON THIS. IN A FEW 

25 YEARS, JUST A FEW, WE ARE GOING TO HAVE A DEFICIT IN 
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1 PHYSICIANS IN THIS COUNTRY OF SOMETHING LIKE 200,000. I MEAN, 

2 WE GOT TO COME UP WITH A PARADIGM SHIFT OR WE'RE GOING TO -- I 

3 KNOW WE'VE GOT HEALTHCARE REFORM, WE'VE GOT A LOT OF THINGS IN 

4 FLUX NOW. BUT I JUST ASK THIS BOARD TO COME DOWN AND HAVE MR. 

5 KATZ COME DOWN HERE ON A WEEKLY BASIS, REPORT BACK, AND TELL 

6 US WHAT WE'RE DOING TO LOWER THAT NUMBER AND GET THIS THING 

7 BACK ON TRACK. THANK YOU. 

8

9 SUP. YAROSLAVSKY, CHAIRMAN: THERE'S NO DISCUSSION ON THAT 

10 ITEM? THEN KNABE MOVES, I'LL SECOND. RECEIVE AND FILE. WITHOUT 

11 OBJECTION, SO ORDERED. ON ITEM NO. 10, I'D LIKE TO RECONSIDER 

12 FOR THE PURPOSE OF BEING RECORDED AS A NO VOTE. IT WON'T 

13 CHANGE THE RESULT. SO IF THERE'S NO OBJECTION? RECONSIDER IT. 

14 AND I'LL BE RECORDED AS A NO VOTE. SO THE VOTE IS 3-2 IN 

15 FAVOR. SO ORDERED. MR. ANTONOVICH, DO YOU HAVE ANY OBJECTION 

16 ON THAT ITEM, IF THE C.E.O. WOULD REPORT BACK TO US WITHIN TWO 

17 WEEKS HOW THIS DIVIDE BY FIVE WOULD BE EXECUTED? BECAUSE I 

18 WANT TO MAKE SURE THAT IT IS -- THAT THESE FUNDS ARE USED FOR 

19 ECONOMIC DEVELOPMENT PURPOSES, AND HOW THAT COULD BE 

20 STRUCTURED. AND IT DOESN'T JUST MORPH INTO GENERAL PURPOSES 

21 KINDS OF THINGS. 

22

23 C.E.O. FUJIOKA: WE'LL WORK WITH EACH OFFICE, SIR, TO DO THAT. 

24
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1 SUP. YAROSLAVSKY, CHAIRMAN: YEAH. YEAH, OKAY. SO WORK WITH THE 

2 BOARD ON THE GUIDELINES AND HOW THAT'S GOING TO BE DONE, OKAY? 

3 THANK YOU. ANYTHING ELSE BEFORE US? LET ME CALL UP FOUR 

4 PEOPLE. SIDNEY COSBY, ALFREDO RAMIREZ, ARE THEY HERE? MR. 

5 RAMIREZ? IRENE PANG. AND ERIC PREVEN? 

6

7 ERIC PREVEN: MY NAME IS ERIC PREVEN AND I AM THE COUNTY 

8 RESIDENT FROM DISTRICT 3. SOME INTERESTING DISAGREEMENTS 

9 BETWEEN THE BOARD TODAY. I WISH THAT SUPERVISOR ANTONOVICH, 

10 WHO TOOK A STRONG TACK AGAINST THE ELECTORATE HAVING TO COME 

11 UP WITH SOME MORE WATER MONEY FELT THE SAME WAY WITH RESPECT 

12 TO PARKS AND REC'S REVENUE AS DERIVED FROM OUR GOLF COURSES 

13 AND OTHER LESSEES. WE HAVE TAKEN NOTE THAT ON JUNE 21 OF 2011, 

14 SUPERVISOR ANTONOVICH WAS NOT AS ENTHUSIASTIC ABOUT FOREGOING 

15 $5.6 MILLION IN, YOU KNOW, LOST -- THEY HAD FAILED TO PAY 

16 THEIR TAXES, AND HE WAS WAIVING THAT FOR NEW DEVELOPERS WHO 

17 WERE EVENTUALLY, I FOUND OUT, TIED TO A TEXAS MALL. AND YOU 

18 KNOW, THAT'S REVENUE THAT WE CERTAINLY COULD HAVE USED HERE IN 

19 L.A. COUNTY. AND, YOU KNOW, IT'S JUST I UNDERSTAND THAT 

20 THERE'S A LITTLE BIT OF PARTISAN POLITICS GOING ON DOWN HERE. 

21 AND WE CAN DO OUR BEST TO STAY OUT OF THAT. I JUST WANT TO 

22 COMMENT ON ANDY GRIFFITH BECAUSE I WATCHED THAT SHOW AS A KID. 

23 AND HE WAS TRULY -- MAYBERRY WAS KIND OF A MODEL FOR CIVIC 

24 ENGAGEMENT. THIS WAS A GREAT SHERIFF WHO WAS COMPLETELY 

25 TRUSTED AND TRUSTWORTHY. ON JULY 6, WE ARE DEALING WITH 



July 3, 2012

73

1 ANOTHER MEETING OF THE CITIZENS COMMISSION ON JAIL VIOLENCE. 

2 AND I WOULD ENCOURAGE THE PUBLIC TO COME DOWN AND HEAR BECAUSE 

3 APPARENTLY LEE BACA AND THE UNDERSHERIFF ARE GOING TO MAKE A 

4 PRESENTATION OF SOME KIND. AND, YOU KNOW, WE'VE STRUGGLED WITH 

5 THIS STUFF. AND I KNOW THESE ARE ALSO COMPLICATED ISSUES. AND 

6 I WOULD THANK THE BOARD AND THE CITIZENS COMMISSION ON JAIL 

7 VIOLENCE FOR MAKING SOME OF THOSE TRANSCRIPTS AVAILABLE AT THE 

8 C.C.J.V.'S WEBSITE. BUT I'M LOOKING FORWARD TO THE DAY WHEN WE 

9 CAN KIND OF RIGHT THE SHIP A LITTLE BIT AND GET SOME OF THIS 

10 STUFF BACK ON TRACK. AND I JUST WANT TO SAY THANK YOU TO 

11 SUPERVISOR RIDLEY-THOMAS. IT IS WITH THE UTMOST RESPECT THAT I 

12 THANK HIM FOR HIS CONTRIBUTION TODAY. THANK YOU. 

13

14 SUP. RIDLEY-THOMAS: THANK YOU FOR YOUR TESTIMONY. OUR NEXT 

15 SPEAKERS ARE SIDNEY COSBY, ALFREDO RAMIREZ. 

16

17 SIDNEY COSBY: GOOD MORNING, MY NAME IS SIDNEY COSBY. I'M HERE 

18 ON BEHALF OF THE WEST ATHENS AREA WITH THE HORSE STABLES WHERE 

19 ACTUALLY UNFORTUNATELY CAUGHT ON FIRE AND THREE HORSES PASSED 

20 AND ONE GOAT. SOME OF US AND MOST OF US HAVE A LOT OF ISSUES 

21 WITH RELOCATING OUR ANIMALS. WE'VE CONTACTED -- AS OF TODAY, 

22 WE'VE CONTACTED AT LEAST FOUR STABLES IN OUR IMMEDIATE AREAS 

23 WHERE WE CAN AFFORD TO TAKE CARE OF OUR HORSES. OUR HORSES ARE 

24 VERY WELL TAKEN CARE OF. OUR AREA, WE BELIEVE, IS NOT INHUMANE 

25 FOR OUR ANIMALS. ONE ISOLATED AREA WE DON'T BELIEVE SHOULD 
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1 MAKE US HAVE TO RELOCATE OUR ANIMALS. WE CARE FOR THESE 

2 ANIMALS LIKE IF THESE ARE OUR KIDS. I HAVE NO BIOLOGICAL KIDS, 

3 BUT I DO OWN FOUR ANIMALS. I CAN AFFORD MY ANIMALS, AND I 

4 WOULD NOT WANT MY ANIMALS TO BE REMOVED TO AN AREA WHERE I 

5 WOULD HAVE TO PAY SOMEBODY $500 PER ANIMAL TO TAKE CARE OF 

6 THEM. I CANNOT AFFORD THAT. I WANT TO SAY THIS ON RECORD, IF 

7 YOU GUYS BELIEVE, THE AGENCIES BELIEVE THAT OUR HORSES ARE NOT 

8 TAKEN CARE OF OR IN AN AREA THAT IS NOT SAFE FOR THEM, PLEASE 

9 COME AND GET MY ANIMALS TODAY. PLEASE DO. THAT IS MY HEARTFELT 

10 PASSION. IF YOU REALLY BELIEVE THAT MY ANIMALS ARE IN DANGER, 

11 COME GET THEM TODAY. IN ADDITION TO THAT, WE ARE IN 

12 COMPLIANCE. WE ARE WILLING TO COMPLY. WE HAVE NO PROBLEM WITH 

13 COMPLYING. AT THIS CURRENT TIME, THERE ARE STILL 120 ANIMALS, 

14 HORSES AT THE STABLE THAT CANNOT BE MOVED IN AN IMMEDIATE 

15 AREA. WE HAVE MONEY TO TAKE CARE OF OUR HORSES. WE ASK FOR 

16 VARIOUS SOLUTIONS THAT WE'RE WILLING TO PUT A PROPOSAL 

17 TOGETHER FOR LOS ANGELES COUNTY, FOR THE SUPERVISORS, FOR OUR 

18 PERSON, WHO IS THE M.R.T. IN OUR AREA TO AT LEAST RATIFY THIS 

19 ISSUE WHERE WE TAKE CARE OF ONE SIDE OF THE STABLE FIRST TO 

20 KEEP IT CLEAR AND THEN MOVE THE HORSES TO ONE SIDE AND THEN 

21 VICE VERSA. 

22

23 SUP. RIDLEY-THOMAS: THANK YOU FOR YOUR TESTIMONY, MR. COSBY. 

24 NEXT SPEAKER, PLEASE, MR. RAMIREZ? SIR? 

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: YEAH, HE'S -- SO YOU ARE TOGETHER? 

2

3 ALFREDO RAMIREZ: TOOK NAME AND EVERYTHING. 

4

5 SUP. YAROSLAVSKY, CHAIRMAN: DO YOU WANT TO SPEAK OR DID HE 

6 COVER IT FOR YOU? 

7

8 ALFREDO RAMIREZ: HE COVERED FOR ME. THE ONLY THING I GOT 34 

9 HORSES AT HOME, SO IT'S AFFECTING ME MORE, TOO. THAT'S ALL I 

10 WANTED TO SAY. 

11

12 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. 

13

14 SIDNEY COSBY: YOU KNOW, OUR GOAL IS TO ACTUALLY GET -- WE'VE 

15 BEEN GETTING A LOT OF VERBAL INFORMATION. ONE PERSON SAYS 

16 THEY'RE GOING TO HELP US, ONE PERSON SAYS WE NEED TO JUST MOVE 

17 THE HORSES. WE KNOW WE CAN'T MOVE THE HORSES. WE KNEW WE 

18 COULDN'T MOVE THEM IN 24 HOURS. WE KNEW WE COULDN'T MOVE THEM 

19 IN 10 DAYS. WE KNOW 15 DAYS IS NOT ENOUGH, AS WELL. AGAIN, 

20 WE'VE LOOKED IN EVERY IMMEDIATE STABLE IN OUR AREA, AND WE 

21 CANNOT FIND SOMEBODY WILLING TO TAKE THESE ANIMALS. 

22

23 SUP. RIDLEY-THOMAS: ALL RIGHT, MR. CHAIRMAN, IF I MAY? 

24

25 SUP. YAROSLAVSKY, CHAIRMAN: YES, SIR. 
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1

2 SUP. RIDLEY-THOMAS: ALL OF THESE ANSWERS, ALL OF THESE ISSUES 

3 SHOULD BE EFFECTIVELY SPOKEN TO IN A PUBLIC WAY ON NEXT 

4 TUESDAY, JULY 10, AT THE ATHENS PARK WHERE WE'LL HAVE A PUBLIC 

5 MEETING AS I DID PROMISE TO ANSWER ANY OF THE QUESTIONS AS 

6 WELL AS GIVE AN UPDATE ON WHERE THINGS ARE. THE COUNTY 

7 COUNSEL, THE FIRE DEPARTMENT, SHERIFF'S DEPARTMENT, PUBLIC 

8 WORKS, A RANGE OF OTHER ENTITIES, THE D.A.'S OFFICE, FOR 

9 EXAMPLE, ARE ALL INVOLVED IN THIS MATTER SO THAT WE CAN 

10 SERVICE TWO PRIMARY OBJECTIVES: ONE IS PUBLIC SAFETY, TWO IS 

11 PUBLIC HEALTH. IT SHOULD BE KNOWN THAT CONVERSATIONS HAVE 

12 COMMENCED WITH THE PROPERTY OWNER. SO MANY OF THE ISSUES THAT 

13 ARE IN PLAY ARE REALLY RELATED TO THE RESPONSIBILITIES OF THE 

14 PROPERTY OWNER. WE'LL LAY ALL OF THIS OUT IN DETAIL A WEEK 

15 FROM TONIGHT, ATHENS PARK, 6:30. FLYERS WILL BE CIRCULATED SO 

16 THAT EVERYBODY KNOWS WHAT'S HAPPENING. IF THERE ARE ANY 

17 QUESTIONS OR COMMENTS PRIOR TO THAT, FEEL FREE TO BE IN 

18 CONTACT WITH OUR OFFICES. 

19

20 SIDNEY COSBY: OKAY. WE APPRECIATE THAT. BUT I MEAN FOR ME AND 

21 MOST OF US AT THE STABLE, WE WOULD REALLY LIKE TO HAVE 

22 SOMETHING IN WRITING OF THE THINGS THAT HAVE BEEN VERBALLY 

23 SAID TO US. 

24
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1 SUP. RIDLEY-THOMAS: IT WILL ALL BE IN WRITING. IT WILL ALL BE 

2 DONE. 

3

4 SIDNEY COSBY: AS FAR AS ASSISTING US IF WE CAN'T MOVE OUR 

5 HORSES, THAT SOMEBODY WOULD HELP THEM TAKE CARE OF THEM FOR 

6 FREE. 

7

8 SUP. RIDLEY-THOMAS: IT WILL BE A LOT CLEARER A WEEK FROM 

9 TONIGHT. THANK YOU FOR YOUR TESTIMONY. MR. CHAIRMAN. 

10

11 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. MISS PANG? 

12

13 IRENE PANG: HI, I'M IRENE. I'M CONCERNED PRESIDENT BUSH 

14 RETURNED TO HIS BEGINNING OF THE SECOND TERM. IN FACT, IN THE 

15 BEGINNING OF BUSH SECOND TERM, LARGE AMOUNT OF THE MONEY 

16 BUDGET LOSS. MOST OF THE CITIZEN IS THE SAME AS BUSH IS 

17 CONCERNED. HOW TO MEET THE EXPENSES OF THE NATIONAL AT THE 

18 SAME TIME BUSH SKIN CANCER OF HIS BACK TAKE SERIOUSLY IN SUCH 

19 CONDITION BUSH OFFER THEM HIS OFFICE OF THE PRESIDENT. IN 

20 PRESENT TIME THEY'RE USING MONEY OF THE NATIONAL FUND BUSH THE 

21 BACK CANCER COVERED IT. IN PRESENT TIME, BUSH RETURNED TO HIS 

22 BEGINNING OF THE SECOND TERM OF PRESIDENT OF THE UNITED 

23 STATES. I BELIEVE THAT -- WHEN BUSH OFFER HIS OFFICE. A LOT OF 

24 CITIZEN SUFFER FROM THE LOST PROPERTY INCLUDING REAL PROPERTY 

25 AND PERSONAL PROPERTY. SECOND, I CONCERNED OUR NATION SHOULD 
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1 CONCERN THE RECOGNIZING OF THE OWNERSHIP OF THEIR TRUE OWNER 

2 OF THEIR PROPERTY. THIRD, I CONCERNED BY THE SAFETY OF MY 

3 NIECE OR MY LIVE-IN FAMILY MEMBER IS SAME IS THE VICTIM AND 

4 CITIZEN OF THE UNITED STATES. THANK YOU. I CONCERNED MY NIECE 

5 AND MY NEPHEWS, THEIR SAFETY, AND FAMILY MEMBERS, THEIR SAFETY 

6 IN KOREA SAME AS THE VICTIMS AND CITIZEN OF THE UNITED STATES. 

7 THANK YOU. 

8

9 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. ARNOLD SACHS? E.T. 

10 SNELL? MICHAEL TURNER? AND OSCAR JOHNSON. MR. SACHS? 

11

12 ARNOLD SACHS: YES, THANK YOU, GOOD MORNING. ARNOLD SACHS. WELL 

13 MEASURE "R" CERTAINLY TOOK THE CENTER STAGE AT THE METRO BOARD 

14 MEETING, SO I WAS WONDERING, BECAUSE THEY WANT TO EXTEND IT, 

15 NOW IT'S UNLIMITED EXTENSION. WELL WHY NOT THIS, SUPERVISOR 

16 RIDLEY-THOMAS? WHY NOT NO STATION AT LEMERT PARK, NO VOTE. NO 

17 UNDERGROUNDING FOR THE CRENSHAW LINE, NO VOTE. AND THE BIKE 

18 PATHS THAT YOU TALKED ABOUT, SUPERVISOR ANTONOVICH, NO FUNDING 

19 FOR THE COUNTY BIKE PATHS. NO BIKE PATH, NO VOTE. HOW ABOUT 

20 THE DOWNTOWN CONNECTOR? NO STATION, NO VOTE. HOW ABOUT THE 

21 CRENSHAW LINE, NO STATION CONNECTING TO THE WEST SIDE 

22 EXTENSION, NO VOTE. HOW ABOUT THIS IDEA? INSTEAD OF EXTENDING 

23 THAT MEASURE R INDEFINITELY, HAVE IT EXPIRE IN 2039 AND DO 

24 WHAT THE GOVERNMENT DID, THE E.P.A. WHEN THEY TOOK THE ONE 

25 THROUGH COOLING ACTION FOR THE HIGH HYDROELECTRIC FACILITIES, 
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1 YOU KNOW, THE UTILITIES THAT USE OCEAN WATER, THEY IMPLEMENTED 

2 THOSE PLANS TO TAKE EFFECT 50 YEARS. SO THEY WILL BE COMING ON 

3 BOARD IN THE 2020S. SO IN 2039, ENACT A NEW HALF- CENT SALES 

4 TAX TO TAKE THE PLACE OF MEASURE "R," BECAUSE ONCE MEASURE "R" 

5 CONTINUES AND ONCE M.T.A. GETS A HOLD OF THAT FUNDING, IT'S 

6 ALL DOWNHILL. AND BY THE WAY, WHEN MEASURE "R" WAS THOUGHT 

7 ABOUT, IT WAS $40 BILLION OVER THE 30-YEAR PERIOD. AND THERE 

8 SEEMS TO BE A FUNDING SHORTFALL BECAUSE OF THE ECONOMIC 

9 SITUATION. BUT NOBODY'S MENTIONED HOW MUCH THAT SHORTAGE IS. 

10 SO IS IT QUARTER OF A BILLION? THAT'S $250 MILLION. IS IT $300 

11 MILLION? IS IT $100 MILLION? DON'T YOU THINK THAT WOULD BE 

12 FORTHCOMING? DON'T YOU THINK THE PUBLIC HAS A RIGHT TO KNOW? 

13 NO. JUST GIVE US MORE MONEY. MEASURE "R," PROP A, PROP C. FIVE 

14 DIFFERENT PROPS FOR METRO AND YOU DON'T HAVE ENOUGH MONEY. NO 

15 MONEY, NO HONEY. IT'S RIDICULOUS. YOU KNOW, BOSTON HAD THE BIG 

16 DIG, M.T.A.'S GOT THE BIG PIGS. 

17

18 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MR. SNELL? 

19

20 E.T. SNELL: YEAH, E.T. SNELL, THAT'S WWW.ETSNELL.COM. YOU KNOW 

21 ZEV, THIS LITTLE EXAMPLE EARLIER WHERE I ASKED FOR A LITTLE 

22 CONSIDERATION TO ORGANIZE MY PAPERWORK AND LET ANOTHER SPEAKER 

23 GO AND THEN LAST WEEK YOU THREW ME OUT OF HERE, ARGUED WITH 

24 ME. AND THEN THE SHERIFF TOLD ME YOU HAD SAID I COULDN'T SPEAK 

25 AT PUBLIC COMMENT. AND THEN YOU TRIED TO POLITICAL POSITION 
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1 AND THEN CALLED MY NAME. BOY, YOU KNOW, THAT'S -- AND THEN YOU 

2 WONDER WHY I'M BACK IN THE CLOWN COSTUME. DO YOU KNOW WHAT? I 

3 REMEMBER AS A BOY TAKING "ON MY HONOR TO DO MY BEST, TO DO MY 

4 DUTY TO GOD AND MY COUNTRY," THE BOY SCOUTS' OATH, AND A SCOUT 

5 MAY FACE DANGER. AND IF HE'S AFRAID, HE HAS THE COURAGE TO 

6 STAND UP FOR WHAT HE THINKS IS RIGHT. AND I'M REALLY ASHAMED 

7 AT THIS BOARD TODAY. TOMORROW'S JULY 4TH. I HAVE HEARD NOTHING 

8 OUT OF ANY OF YOUR MOUTHS ABOUT THE MANY SOLDIERS THAT HAVE 

9 DIED AND THE MANY SOLDIERS THAT ARE GIVING ALL SO THAT YOU CAN 

10 CONDUCT THE CORRUPTION THAT YOU DO HERE TODAY. SO I'M REALLY 

11 APPALLED. YOU KNOW I SAW PUPPIES, I SAW A LOT OF DIFFERENT 

12 THINGS. A LOT OF CORRUPTION GOING DOWN. YOU KNOW, SPEAKING OF 

13 CORRUPTION, THE GRAND JURY -- AND THEN I'M THINKING, I'M FROM 

14 SAN BERNARDINO COUNTY. WE READ OUR PAPER OUT THERE AT THE 

15 GRAND JURY, BOY THEY'RE BUSY OUT THERE. AND THEY'RE BUSY ON 

16 THE COUNTY SUPERVISORS. WHY ARE THEY NOT BUSY HERE? LOOK AT 

17 ZEV, HE WENT TO ISRAEL, THE MARINA DEL REY, $100 MILLION A 

18 YEAR GIVEAWAY, KNABE'S SONS INVOLVED WITH NOGUEZ. THERE'S A 

19 LOT OF QUESTIONABLE THINGS. I DON'T SEE NOTHING HERE. WELL I 

20 KNOW THE GRAND JURY'S ON THE 11TH FLOOR OF THE DISTRICT 

21 ATTORNEY'S OFFICE. I CALLING ON THE F.B.I., I'M CALLING ON THE 

22 DEPARTMENT OF JUSTICE TO GET THEM OFF THE DISTRICT ATTORNEY'S 

23 FLOOR AND PUT THEM IN A PRIVATE PLACE WHERE WE CAN GET SOME 

24 JUSTICE AND SOME LAWS BACK TO NORMAL. THANK YOU AND HAVE A 
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1 GREAT FOURTH OF JULY AND GOD BLESS OUR TROOPS AND THE PEOPLE 

2 THAT GAVE IT ALL. 

3

4 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MICHAEL TURNER? 

5

6 MICHAEL TURNER: HELLO. MY NAME IS MICHAEL TURNER. AND I'M WITH 

7 THE GAIN PROGRAM, THE WELFARE TO WORK. I HAVE A SITUATION 

8 WHERE THAT I HAVE COMPLIED WITH EVERYTHING THAT GAIN ASKED ME 

9 TO DO. I COMPLETED, I'VE BEEN IN SCHOOL FOR FIVE YEARS. I'VE 

10 COMPLETED ALL MY COURSES. AND I NOW HAVE MY CERTIFICATE. I NOW 

11 HAVE A PERSON WHO'S WILLING TO HIRE ME. AND THE TRADE I'M IN 

12 IS AUTO MECHANICS. AND IN ORDER TO BE AN AUTO MECHANIC AND GO 

13 INTO EMPLOYMENT, YOU MUST PROVIDE YOUR OWN TOOLS AND SUPPLIES. 

14 GAIN HAS, WELL, GAIN IS SUPPOSED TO GIVE ME MY SUPPLIES. AND 

15 AS OF TODAY, I HAVEN'T RECEIVED THEM. I WENT AND SPOKE WITH MY 

16 WORKER YESTERDAY CONCERNING MY SUPPLIES, AND I WAS TOLD BASED 

17 ON THE BOARD DECISION IS WHEN I WILL OR WILL NOT RECEIVE MY 

18 SUPPLIES. CAN I GET A COMMENT ON THAT? 

19

20 SUP. YAROSLAVSKY, CHAIRMAN: WEREN'T YOU HERE LAST WEEK? 

21

22 MICHAEL TURNER: YES, SIR. 

23

24 SUP. YAROSLAVSKY, CHAIRMAN: WE HAD SOMEBODY TALK TO YOU ABOUT 

25 IT LAST WEEK? 
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1

2 MICHAEL TURNER: YES, SIR. 

3

4 SUP. YAROSLAVSKY, CHAIRMAN: AND WHAT HAPPENED? 

5

6 MICHAEL TURNER: ACTUALLY NOTHING. I SPOKE WITH MR. THOMAS. 

7

8 SUP. RIDLEY-THOMAS: MR. CHAIRMAN? 

9

10 SUP. YAROSLAVSKY, CHAIRMAN: YES, MR. RIDLEY-THOMAS? 

11

12 SUP. RIDLEY-THOMAS: VERY QUICKLY, MR. TURNER, I WOULD ADVISE 

13 THAT YOU PAY CLOSE ATTENTION TO YOUR MAILBOX. YOU WILL BE 

14 RECEIVING A REGISTERED MAIL EXPLAINING WHAT WE KNOW ABOUT WHAT 

15 HAS TRANSPIRED OVER THE PAST SEVERAL YEARS, THE PAYMENTS YOU 

16 RECEIVED, THAT WHICH THE DEPARTMENT GAIN DEEMS YOU TO BE DUE. 

17 AND WITH THAT, YOU CAN GO TO WORK DOING WHAT YOU NEED TO DO 

18 WITH THE LITTLE STARTUP KIT. BUT PAY ATTENTION TO YOUR 

19 MAILBOX. WE HAVE A LETTER DRAFTED HERE FOR YOUR CONSIDERATION. 

20 AND THAT SHOULD SETTLE THIS MATTER, ALL RIGHT? 

21

22 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. 

23

24 MICHAEL TURNER: THANK YOU. 

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: MR. JOHNSON? BEFORE YOU START, IS 

2 ALICIA TROTTER HERE? ALL RIGHT, COME ON DOWN. MR. JOHNSON. 

3

4 OSCAR JOHNSON: YES. MY NAME IS OSCAR JOHNSON. I SPEAK FOR THE 

5 OPPRESSED, I SPEAK FOR THE STRUGGLING POOR AND I SPEAK FOR 

6 CULTURAL CHANGE. I'D LIKE TO THANK THE MOST HIGH GOD FOR 

7 PRESIDENT BARACK OBAMA. THANK GOD FOR THE OBAMA FAMILY. I'D 

8 LIKE TO SPEAK A LITTLE ABOUT RELIGION AND SOCIAL 

9 RESPONSIBILITY. WE NEED PERSONAL RESPONSIBILITY. I GUESS 

10 PERSONAL RESPONSIBILITY STARTS AT HOME. SOCIAL RESPONSIBILITY 

11 IS IN SOCIETY. AMERICA WOULD BE A MUCH BETTER GOVERNMENT IF WE 

12 COULD LIVE BY THE LAWS THAT GOVERN US. THE CONSTITUTION OF THE 

13 UNITED STATES OF AMERICA IS THE LAWS THAT GOVERN US. WE SHOULD 

14 END CORRUPTION IN GOVERNMENT. WE SHOULD END ILLEGAL 

15 IMMIGRATION. LOS ANGELES, CALIFORNIA HAS THE LARGEST GROUP OF 

16 ILLEGAL IMMIGRATION IN THE UNITED STATES. YOU FIND MORE 

17 ILLEGAL IMMIGRANTS IN CALIFORNIA STATE PENAL INSTITUTIONS THAN 

18 ANY STATE IN THE UNITED STATES. WE SHOULD HAVE SURVEILLANCE 

19 CAMERAS IN THE POLICE CARS AND THE SHERIFF'S DEPUTY CARS 

20 SHOULD NOT BE PATROLLING THE STREETS. THE SHERIFF SHOULD 

21 REMAIN WITH THE PENITENTIARIES. WE SHOULD END ROCK AND ROLL, 

22 SEX AND DRUGS. WE SHOULD STOP DRUGS FROM COMING TO AMERICA. WE 

23 SHOULD END ECONOMIC RACISM IN AMERICA. MANY PREDOMINANT BLACK 

24 NEIGHBORHOODS IN THIS COUNTRY, THERE ARE BLACK ON BLACK CRIMES 

25 ALL OVER AMERICA. BLACKS KILL EACH OTHER EVERY DAY WITH 
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1 HANDGUNS IN AMERICA. AND CHICAGO IS THE NUMBER 1 LEADING CITY. 

2 1 BLACK OUT OF EVERY 10 MINUTE GET KILLED BY A GUN FROM 

3 ANOTHER BLACK. AND I'M SO VERY SURPRISED PRESIDENT BARACK 

4 OBAMA HASN'T TRIED TO CLEAN UP AMERICA FIRST BEFORE START 

5 TAKING HIS FREEDOM DEMOCRACY ABROAD. BUT WE SHOULD THINK THAT 

6 JULY 4, 1776, PRESIDENT JOHN HANCOCK NAMED THIS COUNTRY UNITED 

7 STATES OF AMERICA. THE CONSTITUTION OF AMERICA HAS NOT LEFT 

8 OUT ANYTHING, BUT THE PEOPLES THAT CONTROL THE GOVERNMENT LEFT 

9 OUT WHAT THE DEATH PENALTY SAID IN THE CONSTITUTION. YOU HAVE 

10 TO READ IN ANOTHER BOOK WHAT THE DEATH PENALTY SAY ABOUT THE 

11 CONSTITUTION. IT SAYS CAPITAL PUNISHMENT FOR ALL MURDERERS IN 

12 AMERICA. BUT IT'S A SIN TO FALSIFY, HAVE FALSIFIED OUR 

13 GOVERNMENT. THANK YOU. 

14

15 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MISS TROTTER? 

16

17 ALICIA TROTTER: YES, MY NAME IS ALICIA TROTTER AND WHEN I WAS 

18 HERE ON JUNE 19, THERE WAS A WOMAN WHO CAME, WHO SPOKE AFTER 

19 ME, SHE WAS A BLACK WOMAN IN A WHEELCHAIR AND SHE SAID SHE HAD 

20 M.S. I WANTED TO TALK ABOUT A MEDICAL PREDISPOSITION FOR 

21 ILLNESSES. AND IN MY CASE, I HAVE MULTIPLE SCLEROSIS, AS WELL. 

22 I HAVE THIS BASICALLY BECAUSE THE F.B.I. SPENT A LOT OF TIME 

23 RESEARCHING MY FAMILY HISTORY. MY FATHER'S MOTHER HAD M.S. AND 

24 SHE DIED IN A WHEELCHAIR. AND BASICALLY IF YOU HAVE A 

25 PREDISPOSITION FOR SOMETHING, THEN IF A PERSON JUST MIXES THE 
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1 RIGHT INGREDIENTS, THEN THEY BAKE THE CAKE AND THAT'S YOUR 

2 REALITY. SO THERE'S ABOUT 400,000 AMERICANS WITH M.S. THERE'S 

3 300 MILLION AMERICANS, LESS THAN 1 PERCENT OF THEM ARE BLACK. 

4 I DON'T THINK IT WAS A COINCIDENCE THAT SHE CAME HERE ON THE 

5 19 AND EVEN TRIED TO BECOME MY NEW BEST FRIEND WHEN I LEFT 

6 HERE. BUT I REALLY NEED MY LIFE BACK. THE F.B.I. HAS BEEN 

7 RUNNING ME DOWN FOR 10 YEARS. THEY DID A LOT OF BAD THINGS TO 

8 ME. I NEED TO HAVE MAJOR SURGERY. BUT I HAD SURGERY IN 2004 AT 

9 CEDAR SINAI. AND IF THEY HAD HAD THEIR WAY, I WOULD HAVE BEEN 

10 DEAD WITHIN TWO WEEKS. BUT AT THIS POINT THEY WON'T MAKE THAT 

11 MISTAKE WHEN THEY HAVE BEEN RUNNING SOMEONE DOWN FOR 10 YEARS. 

12 AND MICHAEL JACKSON'S CASE, IT'S HIS THREE YEAR ANNIVERSARY. 

13 AFTER HE DIED, THE FREEDOM OF INFORMATION ACT, THE F.O.I.A., 

14 THE F.B.I. OPENLY ADMITTED THEY HAD BEEN INVESTIGATING HIM FOR 

15 17 YEARS. AND THERE ARE A LOT OF -- OUT THERE. THERE ARE A LOT 

16 OF PEOPLE IN THE MEDICAL INDUSTRY THAT WILL DO WHAT THEY WANT 

17 YOU TO DO SO THAT AN UNFORTUNATE ACCIDENT HAPPENS TO SOMEONE. 

18 SO I REALLY JUST NEED MY LIFE BACK. BUT SINCE I'VE BEEN COMING 

19 HERE, THEY'RE IN YOUR SECURITY BOOTH RIGHT NOW. THEY ARE 

20 WATCHING ME ON ALL THE SURVEILLANCE CAMERAS. YOU GUYS HAD THAT 

21 TWO-HOUR LAYOVER ON THE 19TH. THAT GAVE THEM TIME TO GET THIS 

22 LADY HERE IN A WHEELCHAIR TO SPEAK. 

23

24 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. CLOSED SESSION. 

25
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1 CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, 

2 NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL 

3 CONVENE IN CLOSED SESSION TO DISCUSS ITEM NOS. CS-1 AND CS-2, 

4 CONFERENCES WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION, 

5 AND ITEM NO. CS-4, CONFERENCE WITH LABOR NEGOTIATOR WILLIAM T 

6 FUJIOKA AND DESIGNATED STAFF AS INDICATED ON THE POSTED AND 

7 SUPPLEMENTAL AGENDAS. THANK YOU. 

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25



July 3, 2012

87

1 REPORT OF ACTION TAKEN IN CLOSED SESSION JULY 3, 2012

2

3

4

5 No reportable action was taken on items CS-1, CS-2, or CS-4. 

6

7 In open session, item CS-3 was continued one week to July 10, 

8 2012. 
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1 I, JENNIFER A. HINES, Certified Shorthand Reporter Number 

2 6029/RPR/CRR qualified in and for the State of California, do 

3 hereby certify:

4      That the transcripts of proceedings recorded by the Los 

5 Angeles County Board of Supervisors July 3, 2012,

6 were thereafter transcribed into typewriting under my 

7 direction and supervision;

8      That the transcript of recorded proceedings as archived 

9 in the office of the reporter and which have been provided to 

10 the Los Angeles County Board of Supervisors as certified by 

11 me.

12      I further certify that I am neither counsel for, nor 

13 related to any party to the said action; nor

14 in anywise interested in the outcome thereof.

15      IN WITNESS WHEREOF, I have hereunto set my hand this 9th 

16 day of July 2012, for the County records to be used only for 

17 authentication purposes of duly certified transcripts      

18 as on file of the office of the reporter.

19   

20                    JENNIFER A. HINES 

21              CSR No. 6029/RPR/CRR
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